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About This Guide

About This Guide

This guide is intended for OneStream administrators and IT professionals. It describes how to
manage Smart Integration Connector to connect local data sources to your OneStream Cloud
instance. OneStream Cloud Operations and Support can assist with the tasks needed to set up

Smart Integration Connector:
« Installing or upgrading to OneStream platform version 8.0.

« Enabling Smart Integration Connector in your Cloud instance.

» Assisting with the installation of Smart Integration Connector Local Gateway Server in your
environment.
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Benefits

Benefits

OneStream applications are strategic components in your financial environment. Data from
financial systems is imported to OneStream and contributes to financial closing and reporting
processes. While performing analysis, you leverage data lineage capabilities to make contextual
associations to data sources in your network.

You will need to set up and configure data sources that may be accessed by OneStream
processes. Traditionally, data connectivity between a OneStream Cloud instance and local data
sources is established using a Virtual Private Network (VPN) and all data source credentials and
supporting files are located on OneStream application servers.

The goals for Smart Integration Connector are to establish all required data source connections
without VPN and establish residency and management of data source connections solely in your
network.

With Smart Integration Connector, you can:

» Securely establish connectivity between OneStream Cloud and data sources in your
network without a VPN connection.

» Create and manage network data source integration using OneStream administration
interfaces.

* Locally manage database credentials and ancillary files.

Common Understanding

Use the reference chart below to understand common terms used throughout the product and this
document.

Term Definition

OneStream Windows Application The Windows client facilitating user interface

client access for all user personas to OneStream
applications.

OneStream Windows Application The application server executing all OneStream

Server (App Server) business logic and processing.
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Benefits

Gateway

Gateways define direct channels of integration
between the OneStream Cloud and a local
customer network. Gateways are represented by
a unique gateway key and are configured for
communication to an Azure Relay endpoint.
Gateways carry a 1:1 correlation to a local
gateway. The channel of communication
established from the OneStream gateway and a
local gateway created in Smart Integration
Connector.

Gateway Server

A gateway server carries no unique technical
definition or configuration address. It is the parent
node in a tree control Ul to organize gateways and
typically corresponds to an installed local gateway
server name.

Custom Database Connections

Custom database connections define a named
data source to which OneStream may connect
using Smart Integration Connector for the purpose
of data import, data export, or drill through
querying. The named custom database
connection is referenced in OneStream business
logic (data management objects or business rules)
to initiate data source connectivity. Credentials
and ancillary files required for a designated data
source connection are configured to and reside on
the corresponding local gateway server.

Local Gateway Server

Smart Integration Connector requires a client
installation on Windows servers to establish a
local gateway server. The local gateway server
houses one or more local gateways which are
configured through the OneStream Local
Gateway Configuration. A local gateway server
corresponds 1:1 with a defined gateway server.

Local Gateway

Local gateways define the local customer
endpoint for distinct channels of communication
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Benefits

used by Smart Integration Connector. A local
gateway facilitates connections to local
databases, Web API connections, iPaaS servers,
or sFTP servers and corresponds 1:1 with a
gateway definition on the OneStream Application
Server. To ensure a valid connection, a local
gateway must be configured by importing the
corresponding gateway definition exported from
the OneStream Windows Application client.

Local Gateway Connections

Local gateway connections are defined in the
utility and confirm the connection between the
local gateway and the local data sources. This is
only used for database connections.

Direct Connection (for example, SFTP,
WebAPI)

A direct connection represents a point-to-point
channel to designated resources such as an sFTP
server or Web API (including iPaa$S services). The
OneStream Local Gateway Server Configuration
Utility Ul facilitates configuration of mapped
connections to resources where the on-premises
TCP port is mapped to a server (hostname/IP).

Database Connection

A database connection represents the ultimate
datasource destination for Smart Integration
Connector. A local gateway connection may be a
designated database. The OneStream Local
Gateway Server Configuration Utility facilitates
configuration of required credentials and
supporting files. The identification of a local
gateway connection must correspond to a custom
database connection established to the
OneStream Application Server.

OneStream Local Gateway
Configuration

This utility is where you configure the Local
Gateway Server, Local Gateways and Local
Gateway Connections to data sources.
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Benefits

Architecture

In contrast to a direct data source connection established using a VPN, Smart Integration
Connector makes an indirect connection to data sources, leveraging the Azure Relay service as
an intermediary.

Smart Integration local gateways integrate with on-premises customer environments through a
cloud hosted service called Azure Relay. The locally installed and configured local gateway server
makes the direct connection to data sources and responds to the OneStream application.

@ OneStream”

Smart Integration Connector

@ OneStream” Cloud Customer Environment
00000000000000000000000000 0000000000000000000000000

Databases
(/‘\—B Gateway
—
2‘% Database Connection

O]
e e
> O

Smart Integration
Connector Local SFTP
Gateway Server

0000000000000 00000000000
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{
!

Azure Relay

App Server )
Direct Connection Service

Internet

NOTE: In OneStream, Custom Database Server Connections define the
connection through the gateway to the data source.

The two primary services of Smart Integration Connector are:

+ OneStream Application Server: The application server brokers communication between
the OneStream Cloud instance application and the Azure Relay service.

* Local Gateway Server: Instances of the Smart Integration Connector Local Gateway
Server are installed inside your network and configured to make direct connections to
designated data sources. The Smart Integration Connector Local Gateway Server runs as
a Windows service and brokers communication between local data sources and Azure
Relay using an outbound connection over port 443.

The components of the Smart Integration Connector are:
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Benefits

¢ OneStream Windows Application client

Direct and Database connections (Gateways) configured through System >
Administration > Smart Integration Connector.

NOTE: The SmartintegrationConnectorAdminPage role must be assigned to
a user for this to be visible.

» A Custom Database Connection to the local gateway data source. Custom Database
Connections are configured in System > System Configuration > Application Server
Configuration > Database Server Connections.

NOTE: The ManageSystemConfiguration role must be assigned to a user for
this to be visible.

* OneStream Smart Integration Connector Local Gateway Server

o Local Gateway Connections provide the setup information necessary for the Smart
Integration Connector Local Gateway to connect to local data sources. Local
Gateway Connections are set up through the OneStream Local Gateway
Configuration in the Gateway Connections Settings section.

o Local Gateway Settings provide the connection information to establish the gateway
connection to the OneStream Windows Application. Gateway settings are exported
from the gateway settings in the OneStream Windows Application and imported to
the Local Gateway section of the OneStream Local Gateway Configuration.

Additional Considerations

» To provide high availability, there can be multiple instances of a designated local gateway,
each running on a separate server bound to the same gateway where the services runin an
active / passive (fail over) manner.

« Multiple local gateways can be installed to establish global connectivity to data sources in
different subnetworks.

» Local gateway configuration must align to the corresponding gateway as defined in the
OneStream Windows application. An export process from the OneStream Windows
application gateway user interface can assist with the alignment to ensure corresponding
names and keys are identical.
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Requirements

Requirements

OneStream Smart Integration Connector
Environment Setup

Smart Integration Connector is Generally Available to all SaaS customers starting with
OneStream version 8.0.

« Install or upgrade OneStream to the latest version. See Setup and Installation.

« Work with your IT team to install the latest version of the Smart Integration Connector Local
Gateway Server in your environment.

° Windows Server 2019+
o .NET Framework 4.8
° Minimum of 8 GB of RAM

NOTE: Memory and processor requirements are driven by the
frequency and volume of remote data accessed through the gateway
service or if remote business rules / long running jobs are leveraged.
Typical data-access patterns with 1 million or less records being queried
at a time can be accomplished with 8-16 GB of RAM and two newer
generation processors. For queries returning over 1 million records, 32
GB or more RAM is recommended.

° The installer requires administrative permission on the server to perform the
installation.

o See Smart Integration Connector Local Gateway Server Installation.

« Create a valid database connection string and internally test the connection from the
Windows server to the database. For example , "Data Source=Initialize Catalog= JDE_
TEST;Persist Security Info=True;User ID=sa;Password=xxxx"
Provider="System.Data.SqIClient."
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Requirements

* Be a OneStream administrator to configure corresponding data sources in the OneStream
environment.

Advanced Networking and Whitelisting

If your organization needs to filter and/or whitelist outbound network traffic for the Smart
Integration Connector, you will need to work with your IT team to restrict outbound traffic over port
443 to *.servicebus.windows.net in any firewall, application filter, or web filter. See Advanced

Networking / Whitelisting section for more information. For any additional questions, please reach
out to Customer Support.
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Upgrade Smart Integration Connector for Private Preview or Limited Availability

Upgrade Smart Integration
Connector for Private Preview or
Limited Availability Customers

The following section describes how to upgrade Smart Integration Connector.

Upgrade from 7.2, 7.3, 7.4 to 8.0

This is only required if you are upgrading from 7.2, 7.3, 7.4 to version 8.0. As part of the upgrade,
you can expect the following:

» A copy of the original configuration file from the prior version will be saved.
« Existing gateways should continue to function as they did prior to the install.

« |fthe Smart Integration Connector Windows Service is running, then the service will
automatically be started after install.

If you perform an upgrade and have issues or do not achieve these results, contact OneStream
Support.

1. Install the latest version of OneStream. The latest version can be requested and scheduled
through the OneStream Software Cloud Customer Service Catalog. Make a note in the
details section of the ticket that you want to install and configure the Smart Integration
Connector.

2. Download the OneStream_Connector_#.#.#.zip file from the Solution Exchange.

3. Extract the OneStreamSmartintegrationConnectorGateway.msi from the downloaded zip
file.

4. Backup a copy of your configuration folder C: \Program Files\OneStream
Software\OneStream Gateway\App_Data before upgrading.

5. (Optional) If you are using any Custom DLLs in the Gateway Installation folder
C:\Program Files\OneStream Software\OneStream Gateway, create a backup copy.

Smart Integration Connector Guide 9
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Upgrade Smart Integration Connector for Private Preview or Limited Availability

6. Follow the steps in Setup and Installation to complete your upgrade.

7. Restore the back-up of the Custom DLLs (if applicable) to the Gateway Installation folder.

Previously, it was required that a OneStream Business Rule developer invoking a remote Smart
Integration Function be aware of the data type returned and convert accordingly after the result is
returned.

Example: An example where the returned result was a byte array
involved code that appeared as follows:

bytesFromFile = CompressionHelper.InflateJsonObject(Of System.Byte())
(si,objRemoteRequestResultDto.resultDataCompressed)

The Smart Integration Connector Gateway now provides this type information back to OneStream
and streamlines this conversion process using a newly added property called ObjectResultValue
which is populated.

When invoking the same operation shown above that previously required the type to be
converted, a BR developer can do the following:

bytesFromFile = objRemoteRequestResultDto.ObjectResultValue

Upgrade from 7.1 to 8.0

This is only required if you are upgrading from the 7.1 version to another version. If you are
upgrading from 7.1 to another version, you must redo any previous setup configurations in the
OneStream Smart Integration Connector Gateway Configuration Utility. Any previously
configured data source name must be reconfigured in the utility. You must keep Data Source
Name, Connection String, and Database Provider the same as the previously configured
connections. You can copy this information from the System Configuration page.

Before upgrading to OneStream 8.0 make sure to do the following:
1. Remove all gateways under System > Administration > Smart Integration Connector.

a. Make a copy of the gateway name. You will use this name when creating the gateway
in a version 7.4.
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Upgrade Smart Integration Connector for Private Preview or Limited Availability

2. After all the gateways are removed, remove all custom gateway connections under System
> System Configuration > Application Server Configuration > Database Server
Connections > Custom.

CAUTION: This is imperative. If you do not remove all Custom Gateway
connections, you will need to contact OneStream support to resolve this issue.

a. Make a copy of the Database Server Name, Gateway and Gateway Connection.
You will use these to recreate your Custom Gateway Connections in 8.0.

3. Uninstall the previous version of Smart Integration Connector Gateway from your
OneStream Windows Application Server completely.

4. After gateways and custom connections are removed, you can upgrade to 8.0..

5. After 8.0 is installed, you can follow the rest of this guide. Make sure you use the same
values you copied before removing the gateway and custom database connection.

NOTE: If you used any BR APIs, you will need to update them with Gateway in the
name. For example, if you used BRApi.Utilities.ExecRemoteRelayBusinessRule,
the new business rule name is BRApi.Utilities.ExecRemoteGatewayBusinessRule.
Likewise, any existing business rules specifying a DbProviderType as
DbProviderType.Relay needs to be migrated to DbProviderType.Gateway:

Example:
|

drillBackInfo.DataTable = api.Parser.GetXFDataTableForSQLQuery(si, DbProviderType.Relay, "RevMgmt"..

drillBackInfo.DataTable = api.Parser.GetXFDataTableForSQLQuery(si, DbProviderType.Gateway, "RevMgmt"
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Migration from VPN Considerations

Migration from VPN
Considerations

If you are migrating from a VPN solution to Smart Integration Connector, there are items to take
into consideration. Use the checklist below to prepare yourself for migrating from VPN to Smart

Integration Connector.

NOTE: While migrating, a VPN and Smart Integration Connector can be used in
tandem. This allows for A/B testing and validation prior to disconnecting the VPN

tunnel.

when the VPN can be disconnected.

Checklist Item Complete
Establish and confirm connectivity for all your data sources including any m
supporting DLL files that need to be migrated.

Plan the setup and configuration via Smart Integration Connector for O
inventoried Data Sources. Determine connection type (Database or Direct)

for each Data Source.

Establish and confirm connectivity for all your data sources. m
Take inventory of what you currently use for example, business rules, m
dashboards, queries, grid views, drill-backs, and whitelisted endpoints for

each plan for any updates needed when using Smart Integration Connector

Set up a time with your OneStream Cloud Support Representative to plan O

Smart Integration Connector Guide
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Setup and Installation

Setup and Installation

Smart Integration Connector Setup

You must set up Smart Integration Connector in this order:

1. Install the OneStream Smart Integration Connector Local Gateway Server
(OneStreamSmartintegrationConnectorGateway.msi) on a Windows Server 2019+ in your
environment.

2. Create a Gateway in the OneStream Windows application to connect OneStream Cloud
instance to a Local Gateway.

3. Export the gateway configuration and import this configuration to the Gateway Settings in
the OneStream Local Gateway Configuration.

4. For gateways of type Database Connection, to allow connections to local databases,

a. Define a Local Gateway connection including Data Sources through the
OneStream Local Gateway Configuration.

b. Testany configured Data Sources to confirm they are communicating properly.
Note that testing direct connections may involve building test business rules to
perform proper validation.

c. Define a custom database connection in the OneStream System Configuration
Setup.

When installation is complete, you can access remote data sources using business rules,
member formulas, or dashboard data adapters in OneStream through the Smart Integration
Connector.

Gateway Installation

Smart Integration Connector is available in OneStream from the System > Administration tab.

1. Download the Smart Integration Connector Local Gateway Server installer from the
Solution Exchange.
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Setup and Installation

2. Copy the Smart Integration Connector Local Gateway Server installer to a Windows
Server within your environment.

3. Runthe installer as an administrator. Accept all the default prompts. When completed, the
Local Gateway Server will be installed on your Windows Server.

I IMPORTANT: If you are upgrading, you must follow steps 4-7.

4. Runthe OneStream Local Gateway Configuration Utility.
5. Open the XFGatewayConfiguration.xml file.

IMPORTANT: Do not change the name of the XFGatewayConfiguration.xml file.
The OneStream Smart Integration Connector Gateway Service only references
this XFGatewayConfiguration.xml file upon start-up. The Save As functionality is
used to create a backup of the file. Do not rename, move, or change the location of
the XFGatewayConfiguration.xml file or any reference locations.

6. Save the configuration file.

7. Follow the dialog box and restart the service.

Gateway Terms

The Smart Integration fields define the gateway. You can find more information about this below.

Name The name of the gateway. Gateway names are
completely arbitrary and typically refer to the
region (North East) or data source such as
(SAP).

NOTE: The gateway name cannot be
changed once created and they must be
unique across all environments--both
development and production. You can
delete an existing gateway and recreate
it with a new name.

Description Text describing the role and purpose for the
gateway and the data sources to which it is
connecting.

Smart Integration Connector Guide 14



Setup and Installation

Gateway Server Name

This is the name of the gateway Server that the
gateway is associated with. Select an existing
gateway server or enter a new one.

Web API Key
(Database Connections only)

This is an editable field. You can change your
key as needed. If changed, it must also be
changed in the Smart Integration Connector
Local Gateway Server. It is designed to offer an
additional layer of protection within your
network when invoking APls embedded in the
Smart Integration Connector Local Gateway
Server. The purpose of the Web API Key is to
give you full control on who can access the data
sources in your network.

Gateway Key

This is the cloud-key used to authenticate the
Smart Integration Connector gateway to the
customer OneStream environment. This key
can be rotated in the OneStream Application by
Smart Integration Connector Gateway
administrators and must be the same in both the
remote Gateway service and in OneStream.

Status

Value will be Online if the local gateway is
running and returning heartbeat messages back
to OneStream. If the Smart Integration
Connector Local Gateway Server is
unavailable, stopped, or network connectivity is
interrupted, it will display Offline.

Status Indicators

4 = Gateway_Server
<) SAP_Gateway
<} 50l_Gateway
S} MysSQlL_Gateway

Status indicators give a visual notification based
on the Gateway status. An indicator turns green
on the side menu if the Gateway is Online, red
if the Gateway is Offline, and yellow if the
Gateway is Offline but there is a newer version
of the Local Gateway Server available.

For Direct Connections, the yellow status
should never display.

Smart Integration Connector Guide
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Instance Count

Displays the count of active gateways. Grayed
out by default. While this value is typically 1
when the gateway is online, you may have a
listener count of two or more if there are
redundant active gateways for high availability.
By default, OneStream allows a total of five
active gateways per environment. This can be
increased by contacting support.

Version

(Database Connections Only)

Displays the Smart Integration Connector Local
Gateway Server version. This version may be
different from the deployed version of
OneStream and allows administrators to
observe and monitor versions of Smart
Integration Connector Gateway software
deployed.

Bound Port at Gateway

Remote port bound to Gateway endpoint.
Relational Database Gateways should default
to 20433 while direct connections allow any port
running on a remote host to be used.

Remote Gateway Host

(Direct Connections Only)

Remote port host to Gateway Server. Used if
surfacing an endpoint such as an SFTP Server.
This could be the hostname or IP address on
the network that the Gateway Server resides in.
example: 172.168.4.7 or sftp.mycompany.com

Bound Port in OneStream

(Direct Connections Only)

This is an optional customer defined port that
can be referenced in data management or
business rules to directly access services such
as sFTP and WebAPI. This must be a globally
unique port in a OneStream deployment per
direct connection and should be a TCP port
number > 1024 and <65535. When creating the
gateway, use the default of -1 and OneStream
will automatically assign an open port.

Gateway failures reporting interval (min)

Minutes to wait between reporting gateway

Smart Integration Connector Guide

16




Setup and Installation

failures into the OneStream Error Log. The
default is five minutes and the max is 1440
minutes. If a gateway is unreachable, an item is
put in the error log using this interval value in
minutes and can be adjusted.

Create a New Gateway

Gateways are used to connect OneStream to the Smart Integration Connector Local Gateway
Server over the Azure Relay. You will establish whether the gateway is a direct or database
connection. After the gateway is created, you will need to copy the configuration to the Smart
Integration Connector Local Gateway Server using the OneStream Local Gateway Configuration.

1.

Go to System > Administration > Smart Integration Connector.

. Click @ Create New Gateway.

Enter the Name and Description. For descriptions of the fields in steps 3-6, refer to the
Gateway Information section.

Select the Gateway Server from the drop-down, or enter a new Gateway Server name.

From Connection Type, select a Database Connection or Direct Connection. You will have
to enter different information depending on the connection type you select.

@ Create New Gateway

Name

Description

Gateway Server

Connection Type

MNortheast_HQ

Connector to Northeast Headquarters

Rochester_Gateway_Server

Database Connection
Direct Connection (e.g. SFTP, WebAPI)

NOTE: The Gateway name cannot be changed once created and must be
deleted and re-created.

Smart Integration Connector Guide
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Create a Database Connection

A database connection is used to connect to relational databases such as SQL Server, MySQL,
etc. using ODBC, OleDB or .NET drivers and is also necessary for remote Smart Integration
Functions to execute. It is recommended to have at least one Database connection endpoint per
Gateway Server even if relational databases will not be accessed by OneStream. The Local
Gateway Configuration Utility facilitates configuration of required credentials for associated local
gateway. The identification of a local gateway connection must correspond to a custom database
connection established to the OneStream Application Server.

After you create a new gateway, you can complete the database connection by following these
steps:

1. From Connection Type, select Database Connection. For descriptions of the fields in
steps 1 and 2, refer to the Gateway Information section.

2. EnteraWeb API Key.

) Create New Gateway 0 x
Mame Mortheast_HQ
Description Connector fo Mortheast Headguarters
Gateway Server Rochester_Gateway_Server ¥
Connection Type | Database Connection v
Web API Key #B06353Ar3

QK Cancel
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NOTE: The Web API Key is used as an additional layer of security when
communicating with the Smart Integration Connector Local Gateway Server
internal APls. WebAPI keys are not required, but recommended to enhance
security and can be modified or added at anytime. The Local Gateway Service
introduces a WebAPI| exposed only to OneStream and bound only to localhost on
the server it is deployed to. This WebAPI is inaccessible on the remote network. If
the Local Gateway Service is bound to other network interfaces, it's suggested to
use the WebAPI as a mechanism to enhance security on the remote network
preventing unauthorized use of OneStream WebAPIs.

Create a Direct Connection

A gateway direct connection represents a point-to-point channel to specific remote network
resources such as an sFTP server or Web API (including iPaaS services).

NOTE: Itis required to have at least one Database connection to use a Direct
Connection as the database connection is used to monitor the availability of the
remote Smart Integration Connector Gateway server Note that the existence of a
database connection does not necessarily mean it must be used or configured if
only Direct Connections are desired.

After you create a new gateway, you can configure the direct connection by following these steps:

1.

From Connection Type, select Direct Connection (e.g, SFTP, WebAPI). For
descriptions of the fields in steps 1-4, refer to the Gateway Information section.

Enter the Bound Port at Gateway. This port represents the well-known TCP service to
expose from an on-premises host such as sFTP which would equate to port 22.

NOTE: Note that the remote service port is required to configure the
connection and may require consultation with network or IT resources to
obtain. Itis also required that any firewalls between the Local Gateway Server
and the remote host allows traffic to the destination port specified.

Enter the Remote Gateway Host (for example, localhost). This represents the remote host
name or |P address accessible by the OneStream Smart Integration Connector Local
Gateway Server. If the host or IP address is accessible or resolvable from the OneStream
Smart Integration Connector Gateway service, or using remote resources accessible
through on-premises WAN, it can be exposed for use.
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4. Enter a Bound Portin OneStream. It is recommended to use -1 for this value as the
OneStream application servers will locate an unused and available port to map to this
connection This port number must be globally unique across all application servers in a
OneStream deployment and care should be taken if a specific port is specified. This is the
port that is then used to access the remote host via business rules, data management jobs,
and so on. from OneStream application servers to allow network traffic to traverse to the
remote host and port.

5. Using this direct connection in OneStream is done by accessing localhost: [Bound Port In
OneStream] which will tunnel traffic back to the configured remote Gateway Host to the
configured bound port at gateway.

a. Example: Remote sFTP server at 172.168.3.4 listening on port 22.

b. Bound Portin OneStream is configured as port 45000. Note that when -1 is used, the
selected port number is available/displayed after saving and also surfaced in the
OneStream Error Log.

c. In OneStream Business Rules, you can access the remote host by connecting to
localhost:45000.

d. Ina OneStream Business Rule, this port can also be obtained in code allowing this
port number to be changed without updating Business Rules:

Dim gatewayDetails As GatewayDetails = BRApi.Utilities.GetGatewayConnectionInfo(si,
"northamerica_sftp")
Dim remotePort = gatewayDetails.OneStreamPortNumber
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() Create New Gateway 0 x
Mame northamerica_sftp

Description Morth America sFTP server

Gateway Server Morth_America v
Connection Type Direct Connection {(e.g. SFTP, WebaAPI) r

Bound Port at Gateway 22

Remote Gateway Host 172.168.34

Bound Port in OneStream | -1

OK Cancel

Export and Import the Gateway
Configuration

You must copy the gateway configuration settings and paste them into your Smart Integration
Connector Gateway to establish the connection.

1. Goto System > Administration > Smart Integration Connector.
2. Select the Gateway to export.

3. Click @ Export Gateway Configuration. The Gateway Configuration Details are copied to
the clipboard.
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&) OneStream

Gateway Configuration Details:

The following gateway configuration has been copied to the clipboard. In order to use this
gatewsay this configuration needs to be added to your local Smart Integration Connector
Gateway configuration.

<PortBridgeConnections >
<PortBridge WebApiKey="ABC123"
ServiceBusNamespace="
ServiceBusAccessRuleMame="customer”
ServiceBusAccessRulekey=" >
<HostMappings>
<HostMapping >

oK

4. On your Windows Server, open the OneStream Local Gateway Configuration. This runs
as administrator by default.

5. Select File > Open OneStream Smart Integration Connector Gateway Configuration
File.

6. Select Open the XFGatewayConfiguration.xml file.

7. Click IE' next to Local Gateway Settings.

B Local Gateway Configuration i
Local Gateway Settings (Detail)

Local Gateway Connections (Detail)

8. Click IE' next to Local Gateways.
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@ Local Gateway Settings

El General
' Web API Bind Port : o433
Local Gateways (Collection)

9. Import Cf the previously copied Gateway Configuration.

f Import Gateway Configuration

Import Gateway Configuration

|< PortBridgeConnections>
<PortBridge WebApiKey="ABC123" ServiceBusNamespace="
ServiceBusAccessRuleName="customer" ServiceBusAccessRuleKey="
<HostMappings>
<HostMapping >
«TargetHost>localhost < /TargetHost>
<1-- Test Gateway Today -->
<GatewayMame>rochester_gateway</GatewayName>
< AllowedPorts>20433 < /AllowedPorts >
</HostMapping »
</HostMappings>
</PortBridge>
</PortBridgeConnections>

Apply Cancel

10. Click Apply.
11. Click OK twice.
12. Save the configuration.

13. Click Yes to apply the changes and restart the Local Gateway Server.

New Gateway Key Generation

Smart Integration Connector administrators can rotate the Gateway Key maintained by the

underlying cloud service, however it must be the same for both the Smart Integration Connector

local gateway and the gateway configuration to function properly.
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—

4.

. Select an existing gateway.

Click Regenerate Gateway Key for Selected Gateway.

You must re-export your Gateway Configuration and apply the new settings through the
OneStream Local Gateway Configuration.

Click OK.

Create a Local Gateway Connection to a
Data Source

A data source contains the name, connection string, and database provider for the database of
your choice. You can set up a PostgreSQL, SQL, Oracle, OleDb, MySQL, ODP.net, or Microsoft
ODBC connection here. The data source is configured using the Local Gateway Configuration
Utility. The utility was installed as part of the Smart Integration Connector Local Gateway install.

1.

2.

Start the OneStream Local Gateway Configuration.

Select File > Open OneStream Smart Integration Connector Gateway Configuration
File.

Open the XFGatewayConfiguration.xml.

Click .| to configure Local Gateway Connections details to set up the Data Sources to
local databases, APls, or other on-premises resources.

Smart Integration Connector Guide

24



Setup and Installation

f2 OneStream Local Gateway Configuration

File  Tools

OneStream Smart Integration Connector Local Gateway Configuration File - C\P1 %

H 2
B Local Gateway Configuration
Local Gateway Settings (Detail)
Local Gateway Connections (Detail)
B Additional Settings
Local Application Data Settings (Detail)
Log Settings (Detail)
5. Click E next to Data Sources.
L;»_'j Local Gateway Connections O X
E General
Allow Remote Code Execution True
Data Sources (Collection)
6. Click |i| Add Item to add a new data source.

) Data Sources

B |:| & General

! Data Source Name

T Comectonswng
¥ Database Provider

=

v
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7.

8.

Enter the Data Source Name, Connection String, and select a Database Provider. You
can add as many data sources as necessary. The Data Source Name must be unique for
each connection defined within a specific OneStream Smart Integration Connector Local
Gateway Server. Names can be re-used across deployed instances of the Windows
Service across your network. See the examples below for connection string examples to a
variety of relational data sources such as PostgreSQL, SQL, and ODBC, and Oracle.

NOTE: Oracle databases require drivers and specific configuration provided
by Oracle.

Click OK to save your configuration.

NOTE: The connection strings below include user IDs and passwords. If Integrated
security is desired, you can configure the OneStream Smart Integration Connector
Gateway Service to run under a specific service account versus saving usernames
and passwords in connection strings.

Microsoft SQL Server

Below is an example for setting up a SQL database using the SqlClient provider.

1.

Click " | next to Data Sources.

Click + Add Item to add the data source.

. Data Source Name: Northeast_Sales

Connection String:
with UserID / Password: Data Source=localhost;Initial Catalog=Sales_DB;Persist Security
Info=True;User ID=sa;Password=*****:Max Pool Size=1000;Connect Timeout=60;

using Integrated Security: Data Source=localhost;Initial Catalog=Sales_DB;Trusted_
Connection=True;

From Database Provider, select SqlClient Data Provider.
Click Test Connection to test the data source.

Click OK to save.
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Q) Data Sources o x
Northeast_Sales ¥
' Data Source Name ' Northeast_Sales
* Connection String Data Source=localhost;Initial Catalog=5
L Database Provider SqlClient Data Provider
v

MySQL Data Provider

Below is an example for setting up a MySQL Data Provider.

1. Click E next to Data Sources.

2. Click + Add Item to add a new data source.
3. Data Source Name: Sales_UK

4. Connection String: Server =
localhost;Port=3306;uid=root;pwd=0nestream123!;database=gatewaymysq|;

5. From Database Provider, select MySQL Data Provider.

6. Click |i| Test Connection to test the data source.

7. Click OK to save.

Oracle Database Examples

Connecting to Oracle requires the download and configuration of the Oracle Data Access
Components (ODAC) obtained directly from Oracle’s website. Follow the steps below to get
access to these drivers and files.

1. Go to the latest web page for Oracle .NET and Visual Studio ODAC Downloads for Oracle

Database.
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2. Afterinstallation, the ODP.NET Provider will display as an available Database Provider in
the utility when adding a new data source.

3. The connection string for Oracle databases can be set up to either reference or require a
locally defined thsnames.ora file for the requested data sources.

B General
Data Source Mame

Connection String

Odbc Data Provider
OleDb Data Provider
OracleClient Data Provider
SglClient Data Provider
Mpgsql Data Provider
MySQL Data Provider

| Oracle Data Proviger fnr.\l?l

Example Connection Strings:

+ Oracle Data Provider for .NET: Data Source=oracletest;User
Id=OneStream1;Password="*********.

* Oracle Data Provider without TNSNames.ora: Data Source=(DESCRIPTION=
(ADDRESS_LIST=(ADDRESS=(PROTOCOL=TCP)(HOST=MyHost)(PORT=MyPort)))

(CONNECT_DATA=(SERVER=DEDICATED)(SERVICE_NAME=MyOracleSID))); User
Id=myUsername;Password=myPassword;

OracleClient Database Provider

Below is an example for setting up a OracleClient database provider.

1. Click L""| next to Data Sources.

2. Click + Add Item to add the data source.
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6.

7.

Data Source Name: Sales EMEA

Connection String: Data Source=oracletest;User Id=OneStream1;Password=********

From Database Provider, select OracleClient Data Provider.

v

Click Test Connection to test the data source.

Click OK to save.

Oracle Data Provider for .NET

Below is an example for setting up a Oracle Data Provider for .NET.

1.

6.

7.

Click || next to Data Sources.
Data Source Name: Sales_SouthAmerica

Connection String: Data Source=oracletest;User |d=OneStream1;Password="*******

. From Database Provider, select Oracle Data Provider for .NET.

Click + Add Item to add a new data source.

v

Click Test Connection to test the data source.

Click OK to save.

PostgreSQL (Npgsql Data Provider)

Below is an example for setting up a PostGres database.
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1. Click E next to Data Sources.

2. Click + Add Item to add the data source.

3. Data Source Name: RevenueMgmtPostGres

4. Connection String: Server=localhost;Port=5432;Database=revmgt;User
Id=onestream;Password=>*******

5. From Database Provider, select Npgsql Data Provider.

6. Click |ﬂ Test Connection to test the data source.

7. Click OK to save.

Q} Data Sources O x
RevenueMgmtPostGres + B General
' Data Source Name kevenueMgthostGres
) Connection String Server=localhost:Port=5432:Database=t
L Database Provider Mpgsql Data Provider
v

OleDb Data Provider

Below is an example for setting up an Oracle database. This does not require additional download
and configurations.

1. Click E next to Data Sources.

2. Click + Add Item to add the data source.

3. Data Source Name: Sales_Asia
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4. Connection String: Provider=OraOLEDB.Oracle;Data Source=localhost:1521/XE;Initial

Catalog=myDataBase;User Id=myUsername;Password="********;

5. From Database Provider, select OleDb Data Provider.

6. Click |i| Test Connection to test the data source.

7. Click OK to save.

Q) Data Sources [m]
Sales_Asia + B General
| Data Source Name ! Sales_Asia
t Connection String Provider=0raQLEDE.Oracle;Data Source
¥ Database Provider OleDb Data Provider
-—
v

ODBC Data Provider

Below is an example for setting up a ODBC data source for Oracle.

1. Click E next to Data Sources.

2. Click + Add Item to add the data source.
3. Data Source Name: Sales_Europe

4. Connection String: Driver={Microsoft ODBC for Oracle};Server=(DESCRIPTION=
(ADDRESS=(PROTOCOL=TCP)(HOST=199.199.199.199)(PORT=1523))(CONNECT _
DATA=(SID=dbName)));Uid=myUsername;Pwd=myPassword,;

5. From Database Provider , select Odbc Data Provider.

6. Click |i| Test Connection to test the data source.
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7. Click OK to create the new source

8. Click Save.
@ Data Sources [m

Sales_Europe + B General

7 : Data Source Mame ISaIes_Europe
T Connection String Driver={Microsoft ODEC for Oracle}:Sen
¥ Database Provider Odbe Data Provider
-
v

(Optional) Remove UserlD and Passwords by
Integrated Security

You can remove plain text UserID and Passwords from connection strings in Smart Integration
Connector if your organization has concerns over credential storage in the Smart Integration
Connector Gateway configuration file. This requires running the Windows Service under a
Service Account identity and using integrated security to connect to remote data sources which
eliminates local storage of any plain-text credentials. Additionally, ODBC data sources can be
defined (using a system DNS) to remove credentials from the configuration file.

Update the Local Gateway Connection String

1. Open your OneStream Local Gateway Configuration.
2. Open a Local Gateway Connection.

3. Navigate to the Connection String and use an Integrated or Trusted Security string. For
example: Data Source=localhost,Initial Catalog=OneStream_GolfStreamDemo _
2022;Trusted_Connection=True;

0D Data Sources

Oracle_Test + B General

Sales_Data1 Data Source Name Sales_Datal
t

4 Database Provider SqiClient Data Provider

Splash_Data_Source : Connection String ¢ Data Source=localhostinitial Catalog=0neStream_GolfStreamDemo_2022;Trusted_Connection=True;
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NOTE: Trusted Connections use the UserlD and password you use to log into
the Windows Server.

NOTE: The example above is for SQL server. Trusted connections vary by
Data Provider type.

4. Click OK.

5. Save your Data Source.

Update Permissions on the Service

Next, you need to update the service to run as the user. If the service is not updated, the
connection does not update and errors will occur.

(f) OneStream

Smart Integration Connector remote query failed.
COne or more errors occurred, (The S50 connection could not be established,

see inner exception.)
One or more ermors occurred. (The S5L connection could not be established,

see inner exception.)
The 550 connection could not be established, see inner exception
Received an unexpected EOF or 0 bytes from the transport stream

OK

1. Open Windows Services.

2. Navigate to OneStream Smart Integration Connector Gateway. The service should be
running.
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S Services
File Action View Help
2 |EHEG= HE > e np

L, Services (Local) . Services (Local)
OneStream Smart Integration Mame Description Status
Connector Gateway -{,("; Office 84 Socurce Engine Saves install...

ol
Stop the service -:(, Ofﬂ.ceS\rcManagerAddons .
Restart the service o Offline Files The Offline ...

). OneStream Smart Integration Connector AP| Service Smart Integ...
Descrinti £ OneStream Smart Integration Connector Bridge Service Smart Integ..,

escription: C4 c. - c. -

Srmart Integration Connector Gateway neStream Smart Integration Cennector Gateway Smart Integ... Running
Service Allowing Remote -{_( OpenS5H Authentication Agent Agent to ho...
Connectivity from OneStream Cloud 25/ Optimize drives Helps the c...

3. Right-click and open Properties.
4. Click the Log On tab. Typically, this will default to the Local System account.

IMPORTANT: Before moving on to the next step, ensure that you have the
appropriate permissions and approvals from your IT Administrators to complete
the Log On change. You may need to access Microsoft SQL Server Management

Studio to verify permissions.

5. Change this from Local System account to This account and enter your domain and/or
login that has access to the datasource. Depending on how your SSO is configured, your
account could require your domain name, UserlD, and password. Contact your IT
Administrator if you have questions on your account domain.
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OneStrearn Smart Integration Connector Gateway Properties (Local.. X

General LooOn  Recovery Dependencies

Log on as:
() Local System account

Al sansice t et it 2l

() This account : B
*Fﬂsﬁwurd .IlI.'III.llII.I
Corfirm password: EERAEEER R

Cacs

6. Click Apply.
7. Click OK.

8. Right-click and select Restart to restart and update the service.

Test the Updated Integrated Connection String

You should test your connection through a Data Adapter query to verify your access to Smart

Integration connector. An alternate SQL Query to pulling the first 10-50 rows is sufficient. See
Data Adapters Example.
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Test the Gateway

1. You can test the gateway by double-clicking the OneStreamGatewayService.exe file
located in the installation folder.

NOTE: The Smart Integration Connector Gateway Windows Service must be
in a stopped state to run in the console for test purposes.

The following command window is displayed:

Program Files {x86)\OneStream Softwarel OneStream Relay Service\OneStreamRelayService.exe — m] *

NF] Interacti debug mode detected.
Adding ed database connections...
3 - FirtDB
INF artup - V
6bef-4f14

Address: nssmartic.serviceb)

~ InternalInitialize API host configuration: ht /localhost:20433
ntroller InternalInitialize Example path to command inw 20433 :IntegrationAPI/RunReque|

2. Correct any errors that are displayed in the command window.

3. Inthe OneStream Windows Application client, refresh Gateway Details from System >
Administration > Smart Integration Connector > Your gateway.

¢ You should see the Instance Count change from 0to 1,

« The Status change from Offline to Online. Additionally, status indictators turns
green on the side menu if the Gateway is Online, red if the Gateway is Offline, and
yellow if the Gateway is Offline but there is a newer version of the Local Gateway
Server available. See the second screenshot under this step for a close up of the
indicators.

» The Version field will show the version of the running Smart Integration Connector
Gateway.
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@ Smart Integration Connector Admin - sftp2

Nied olx O

S8 Automation_Gateway_Serv B General (Gateway)

Europe_Server Mame sftp2

i SFTP gateway

Connection Type Direct Connection

vy v v v w

Gateway Server Name

Gateway Key

Status Online

Instance Count 1
B Additional Settings

Bound Port at Gateway

Remote Gateway Host

Bound Port in OneStream
4 S NEWGATEWAYSERVER B

Gateway failures reporting interval {min)
S} newsftp

4 28 North_America
%} mexico_server

B} us_server

o)

4 28 Offline_Gates

<} jl-offline-test

4. Press Enter twice on the keyboard to stop the service in the command window and then
close the command window.

Restart OneStream Smart Integration
Connector Gateway

After communication has been verified, the following Windows Service needs to run in order to
maintain communication with the OneStream Cloud instance. By default, these services are set to
start after a Windows reboot. You can also manually start them using the Windows Service control
manager or the command line using the net start/net stop commands. If you're having issues
restarting the service, refer to Troubleshooting.

1. Open the OneStream Local Gateway Configuration.

2. Click Tools > Restart OneStream Smart Integration Connector Gateway.
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f2 OneStream Smart Integration Connector Gateway Configuration Utility

File Tools

m1 Restart OneStream Smart Integration Connector Gateway m

H B

Redundant and Fail-over Gateways

The Smart Integration Connector gateway can be installed on a separate Windows Server to
serve as a fail-over. Repeat the steps in Setup the Smart Integration Connector Gateway on a
separate Windows Server. Instead of creating a new gateway, use an existing gateway to export,
or the configuration file can be copied directly from the primary server to the failover server. The
first Connector Gateway that boots or that has the service start will become the active instance
while the second deployment will remain idle until the primary goes offline. The second Connector
Gateway would be the fail-over in this scenario and automatically accept traffic if the primary
instance were to go offline.

@OneStream‘“ Cloud Customer Environment

IIIDEI

(‘/\—\J Local
5@30 Gateway Gateway Local
[ ¢ > N Server #1 Data

Local Gateway  ggurces

App gzum Connectlon(s}
elay
Server(s) Service 9 $
Local
Gateway
Server #2
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Define Custom Database Connections in
OneStream System Configuration Setup

Now that the gateway is set up and communicating with the Smart Integration Connector
Gateway, the final step is to set up the location of the remote data source in OneStream. To
continue adding the Custom Database Connection, you must assign a user to the
ManageSystemConfiguration role.

1. Goto System > Administration > System Configuration.

2. Select Application Server Configuration > Database Server Connections.

@ Ssystem Configuration

O x O W

4 2 Application Server Configuration
~ General
A Environment
~ Memary
A Multithreading

# Recycling

4 B Database Server Connections

3. Select @ Create Item to create a new Custom database server connection.

NOTE: If only fields displayed are Name and External Database properties,
then verify current user is assigned the ManageSystemConfiguration role.

4. Enter the Name of the Database Server Connection.

5. For Database Provider Type select Gateway.

: Database Provider Type ] Gateway N

Gateway Name roch SQL Server
Data Source Name Sale OLEDB
& Timeoul its ODBC
Comman d Timeout it B SAP
Command Timeout Large u |EMAIL
Gateway
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6. The Gateway name dropdown will be populated with a list of configured Gateways. Select
the Gateway.

7. After the Gateway is selected, the Data Source Name dropdown populates with a list of the
Local Gateway Server Database Connections.

8. Select a Database Connection from the dropdown.

NOTE: If the remote data source is not displayed or the Gateway is offline,
"Custom" can be selected allowing the data source to be manually specified.

9. Click Save to complete the configuration.

10. Verify the customer database connection is under Custom.

(7)) System Configuration

X O H

4 > Application Server Configuration
A~ General
2 Environment
2 Recycling
4 B Database Server Connections
» B Internal
» & External
4 B cCustom
|

SALES_DATA
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Smart Integration Additional Settings
Local Application Data Settings

Additional application configurations can be within the Local Application Data Settings.

Once you open a configuration file within the utility, select the ellipsis for the Local Application
Data Settings.

Qj' Local Application Data Settings O x

Maximum Records to Return when Paging 1000000

Maximum Records to Return 5000000

Row Count to Begin Paging Operations 1000000

Settings (Collection)
You can:

+ Reference Location of NET DLLs

» Store Configuration Values

NOTE: These are optional and are only defined if needed or if further turning is
necessary by a consultant or as instructed by support.

Referenced BusinessRule AssemblyFolder

The field Referenced BusinessRule AssemblyFolder specifies the location of customer-supplied
.NET DLLs that can be referenced when remote Smart Integration Functions are compiled and
executed. The default value if blank is the installed location of the Smart Integration Local
Gateway = "C:\Program Files\OneStream Software\OneStream Gateway".

NOTE: Per OneStream Platform Versions 8.0 and above, ERPConnect.45.dll are
not included by default. Refer to Support for SAP Integration if you are integrating
with SAP.
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« The example on the right shows the location c:\ReferencedAssemblies specified.

* The example on the left shows the field is blank. If the field remains blank, the default
location of the installation folder will be used for any referenced DLLs.

@ Local Application Data Settings gr? Local Application Data Settings o x
B General B General

| Referenced BusinessRule AssemblyFolder Referenced BusinessRule AssemblyFolder | c\ReferencedAssemblies

Maximum Records to Return when Paging 1000000 Maximum Records to Return when Paging 1000000

Maximum Records to Return 5000000 Maximum Records to Return 5000000

Row Count to Begin Paging Operations 1000000 Row Count to Begin Paging Operations 1000000

Settings {Collection) Settings (Collection)

OK Cancel OK Cancel

This location path is used to locate Referenced Assemblies (.NET DLLs) required to run remote
Smart Integration Functions. You will need to add the DLL name to the Smart Integration
Functions Referenced Assemblies property.

There are two scenarios that explain what location path would be used based on the Reference
Assemblies properties in the OneStream Windows Application client, and the Referenced
BusinessRule AssemblyFolder property in the OneStream Local Gateway Configuration utility.

OneStream Windows Client Application OneStream Local Gateway Configuration
) Business Rules - AzureSFTP ‘,Z') Local Application Data Settings
DX OHI®| v w| DI L BsEel N
= - ‘|Referenced BusinessRule AssemblyFolder
+ [ Finance E— i y
v [ Parser coneral Maximum Records to Return when Paging 1000000
v [ Connector = Maximum Records to Return 5000000
Mame AzureSFTP . . .
- . Row Count to Begin Paging Operations 1000000
4 Im Smart Integration Functi Type Smart Integration Function . N
X AzureSFTP i Settings (Collection)
* Azure Language Type Cc#
E-_Referenced Assemblies | WinSCPnet.dll Q’: Local Application Data Settings
B General
Referenced BusinessRule AssemblyFolder ¢ c\ReferencedAssemblies
Maximum Records to Return when Paging 1000000
Maximum Records to Return 5000000
Row Count to Begin Paging Operations 1000000
Settings (Collection)

1. Inthis example, the Referenced BusinessRule AssemblyFolder field in the utility is
blank. So the Smart Integration Function would attempt to locate the .NET DLL
(WinSCPnet.dll) in the installation folder, for example C: \Program Files\OneStream
Software\OneStream Gateway\WinSCPnet.dll.
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2. Inthis example, the Referenced Assemblies property is WinSCPnet.dll for a Smart
Integration Function. The Reference BusinessRuleAssemblyFolder is
c:\ReferencedAssemblies. The Smart Integration Function would attempt to locate the
.NET DLL using c:\ReferencedAssemblies\WinSCPnet.dll using the defined Gateway.

NOTE: Maximum Records and Row Counts Settings: When large data volumes are
returned (over 1000000) rows, to maintain performance and reliability, Smart
Integration Connector automatically transfers the data in pages.

I NOTE: Smart Integration Connector has a threshold limit of 5 million rows and
5GB.

Maximum Records to Return when Paging

Defaults to 1000000 and defines the number of rows to return per page/block to OneStream APIs.
Note that this value is used only when the greater than the "Row Count to Begin Paging
Operations" rows are returned from a query. Example: Query returns 3 million rows and Row
Count to Begin Paging is 1 million, there would be 3 blocks of 1 million rows returned to
OneStream.

Maximum Records to Return

Defaults to 5000000 and is the maximum number of rows that can be returned from any one
query.

The maximum recommended number of records to return is 5 million and is the default. Additional
RAM/CPU resources would be required on the Smart Integration Connector Gateway Server and
on the remote database server to surface large quantities of data. Should this limit be exceeded,
You will receive a "Smart Integration Connector Remote Query" error.

NOTE: Itis strongly recommended that you review any queries that return more
than 1 million rows with your Database Administrator, as additional tuning maybe
required. Tuning these queries will improve performance, reduce resource usage,
and make them more efficient.

Row Count to Begin Paging Operations

Defaults to 1000000 and is the number of rows returned before the dataset is returned through
pages and/or blocks.
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Settings - Store Configuration Values

This is where you can set key value pairs such as Web APl keys, usernames, and passwords that
can be referenced from business rules.

For example, the Setting Name is sftpPassword. The sensitive information such as the password
is stored in the Setting Value on the Local Gateway Server, and does not need to be stored in the
OneStream Windows Application.

) Local Application Data Settings = 7 Settings o x
B General

sftpiPassword + B General
Referenced BusinestRule AssemblyFolder

Setting Name sfipPazsword

|Se|l ngs | [Collection) — t ! Setting Value ¢ Seerat
L

Cancel OK Cancel

After this, in a business rule, you can reference the Setting Name and do not need to know the
password or other sensitive information that is stored in the Setting Value. For example, in the
business rule below the sftpPassword Setting Name is referenced. The
GetSmartintegrationConfigValue API can be used in a Smart Integration Function to reference
the Setting Name, which may be needed in a business rule to access a local data source.

Dim passwordString As String = APILibrary.GetSmartIntegrationConfigValue("sftpPassword™)

Log Settings

The service uses Serilog for application-level logging and exposes options for controlling naming
convention, growth limits, and retention details. For example you can change the verbosity of log
messages by changing the minimume-level setting from Verbose to Informational. If a
catastrophic error happens, you can check the Windows event logs to review the errors. You can
edit the Log Settings from the OneStream Local Gateway Configuration Utility.
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f2 OneStream Local Gateway Configuration - m| X

File  Tools

OneStream Smart Integration Connector Local Gateway Configuration File - C\Program Files\CneStream Software\C X
H H

Bl Local Gateway Configuration

Local Gateway Settings {Detail)

Local Gateway Connections [Detail)
B Additional Settings

Local Application Data Settings (Detail)

Log Settings {Detail)

Click IE' to access Log Settings.

@ Log Settings
H General
Log Level Verbose
File size Limitingytes  pooooooo
Roll On File Size Limit True
Retained File Count Limit 40

* Log Level descriptions:
° Verbose: The noisiest level, rarely (if ever) enabled for a production application.

o Debug: Used for internal system events that are not necessarily observable from the
outside, but useful when determining how something happened.

° Information: Used to describe things happening in the system that correspond to its
responsibilities and functions. Generally, these are the observable actions the
system can perform. This is recommended for production environments.

o Warning: Service is degraded, endangered, or may be behaving outside of its
expected parameters.

o Error: Logging of situations where functionality is unavailable or a recoverable error
condition occurred.
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o Fatal: Only the most critical level items would be logged, requiring immediate
attention.

« File Size Limit in Bytes: The maximum size for the log file, in bytes, before creating a new
file for the day. The default is 20 MB.

* Roll On File Size Limit: When a log file reaches the specified number of bytes, a new log
file is generated.

« Retained File Count Limit: Number of log files to retain. If logs do not exceed the limitin
bytes (one file/day), this would allow for the configured value, with 40 days being the
default, of log retention. If the Smart Integration Service is used heavily and log files are set
to higher levels of verbosity, this could result in fewer days of log retention. Ensure that the
growth rate and retention periods align with your organizational requirements.

The default location for log files is:
%programdata%\OneStream Software\OneStreamGatewayService\Logs.
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Advanced Networking and
Whitelisting

You can whitelist Azure Relay. Use the following steps to perform this action.
1. Setthe outbound port to 433. This needs to be open to communicate with Azure Relay.

2. (Optional) If you would like to lock down the firewall further, you can limit the traffic to a
specific Azure Relay namespace.

a. Addthe namespace <*.servicebus.windows.net> or go to the Local Gateway
Server Configuration > Local Gateways to obtain the namespace for your Azure
Relay. The namespace would look something like
this:<somehost>.servicebus.windows.net.

@ Local Gateways o x

©%

rochester_gateway B Genera |

Web API Key ABC123

Gateway Kev

Namespace servicebus.windows.net
ReMmote Gateway Host TEeaTRERE

Bound Port at Gateway 20433

NOTE: The namespace will be different for your development and production
environments.

1. (Optional) Additionally, you can lock down traffic further from an IP address by following
these Azure specific instructions:

a. Whitelist all IP addresses returned by this script.

b. You will need to review these IP addresses periodically as Microsoft may change
these. Published changes are found on the Microsoft Community Hub.
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Use Smart Integration Connector

Use Smart Integration Connector

You can use Smart Integration Connector to access data from your Local Gateway Connection

Data Source or through Direct Connections.

Examples

Data Adapters Example

1. Goto Application > Presentation > Dashboards > Workspaces > [choose
Workspace] > [choose Maintenance Unit] > Data Adapters.

2. Create or select an existing data adapter.

3. Verify that the Database Location is External and the External Database Connection is
the custom connection that you defined earlier.

4. Enteravalid SQL Query.

B General (Data Adapter)

Maintenance Unit
E Data Source
Command Type

Database Location

S0l

External

External Database Connection

SOL Query

Mortheast Sales

select * from [Sales_2022].[dbo].[NE_Sales]

Results Table Name

5. Test © the data adapter and view the results.
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SQL Table Editor Example

The following use case describes how to send a query after establishing a connection.

1. Go to Application > Presentation > Dashboards > Workspaces > [choose
Workspace] > [choose Maintenance Unit] > [choose Maintenance Unit] >
Components > SQL Table Editor.

2. Create or open a SQL Table Editor.
3. Verify the following:
+ Database Location is External,
« External Database Connection is the custom connection that you defined earlier,

» Table Name is defined that the table you want to return data from.

B SQL Table Editor
Database Location External
External Database Connection NE Sales Data
Schema Name

Table Name MNorthEast_Sales

4. Open the associated dashboard and run the query. The OneStream Smart Integration
Connector will connect to the external database. If it connects correctly, the query will
populate.

Grid View Example

1. Go to Application > Presentation > Dashboards > Workspaces > [choose Workspace]
> [choose Maintenance Unit] > [choose Maintenance Unit] > Components > Grid
View.

2. Create or open a grid view.
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3. Configure the grid to use the data adapter.

4.

Component Properties [IREIERGEICTH

4 7] Data Adapters
& Northeast Sales Data Adapter

Run the associated dashboard to see the data.

Perform a Drill Back

The following snippet describes how to load data from a local gateway connection data source
and how to perform a drill back. The example below has been updated from the Standard SQL
Connectors business rule. If you do not have the Snippet Editor with the OneStream Application,
you can find the Snippet Editor on the MarketPlace.

1.

2.

Download the Snippet Editor from the MarketPlace.
Navigate to Application > Tools > Business Rules.
Open Connector.

Navigate to Snippets > SQL Connector > Standard SQL Connectors.

. Copy the Sample Business Rule.

Edit the query information. Enter dim ConnectionStringGateway As String = Your
Connection information.

NOTE: This example assumes that you have completed the setup and
installation process and configured a custom database connection in the
System Configuration as a Gateway type. Refer to Define Database Location
in OneStream for more information.

Dim connectionstring As String = GetConnectionString(si, globals, api)

Dim connectionString_gateway As String = GetConnectionString Gateway(si, global3, api)|
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7. Enter the connection name. In this example, “Northeast Sales” is the Gateway Connection
Name as defined in the application configuration.

'Create a Connection string to the External Database (prior to using the gateway)
Private Function GetConnectionString(ByVal si As Sessioninfo, ByVal globals As BRGlobals,
ByVal api As Transformer) As String
Try
"Named External Connection
Return "Revenue Mgmt System"
Catch ex As Exception
Throw ErrorHandler.LogWrite(si, New XFException(si, ex))
End Try
End Function

'"Create a Connection string to the External Database (using the Gateway)
Private Function GetConnectionStringGateway(ByVal si As Sessioninfo, ByVal globais As
BRGlobals, ByVal api As Transformer) As String
Try
'Named External Connection - Gateway
Return "Northeast Sales"
Catch ex As Exception
Throw ErrorHandler.LogWrite(si, New XFException(si, ex))
End Try
End Function

8. Enter the drill back information to your database.

If args.DrillCode.Equals(StageConstants.TransformationGeneral.DrillCodeDefaultValue,
StringComparison.InvariantCulturelgnoreCase) Then

'Source GL Drill Down

drillTypes.Add(New DrillBackTypeInfo(ConnectorDrillBackDisplayTypes.FileShareFile, New
NameAndDesc ("InvoiceDocument","Invoice Document™)))

drillTypes.Add(New DrillBackTypeInfo(ConnectorDrillBackDisplayTypes.DataGrid, New
NameAndDesc("MaterialTypeDetail”,"Material Type Detail")))

drillTypes.Add(New DrillBackTypeInfo(ConnectorDrillBackDisplayTypes.DataGrid, New

NameAndDesc("MaterialTypeDetail_Gateway","Material Type Detail (Smart Integration)")))

9. Edit the level of drill back information returned.
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Example: This example shows previously existing code that
leverages a VPN based SQL connection and the Gateway
based method shown in the second "Else If" block.

Else If args.DrillBackType.NameAndDescription.Name.Equals("MaterialTypeDetail”,
StringComparison.InvariantCultureIgnoreCase) Then

Dim drillBackSQL As String - GetDrillBackSQL_L1(si, globais, api, args)

Dim drillBackInfo As New DrillBackResultInfo

drillBackInfo.DisplayType = ConnectorDrillBackDisplayTypes.OataGrid

drillBackInfo.DataTable = api.Parser.GetXFDataTableForSQLQuery(si, DbProviderType.SqlServer,
connectionstring. True, drillBackSQL, False, args.PageSize, args.PageNumber)

Return drillBacklnfo

Else If args.DrillBackType.NameAndDescription.Name.Equals("MaterialTypeDetail_Gateway",
StringComparison.lnvariantCultureIgnoreCase) Then

Dim drillBackSQL As String = GetDrillBackSQL_L1(si, globais, api, args)

Dim drillBackInfo As New DrillBackResultInfo

drillBackInfo.DisplayType = ConnectorDrillBackDisplayTypes.OataGrid

drillBackInfo.DataTable = api.Parser.GetXFDataTableForSQLQuery(si, DbProviderType.Gateway,
connectionstring gateway. True, drillBackSQL, False, args.PageSize, args.PageNumber)

Return drillBacklnfo

Perform a Write Back

You can perform a write back using Smart Integration Connector leveraging the defined
credentials to the local gateway datasource at the Smart Integration Connector Gateway. If the
credentials have permission to insert, update, and/or delete records in a remote datasource, a
OneStream business rule could be leveraged to write-back, update, and/or delete data as needed
to support a financial process.

Example: The following example shows how to insert rows and
columns to a Smart Integration Connector remote database.

Imports System

Imports System.Collections.Generic
Imports System.Data

Imports System.Data.Common

Imports System.Globalization
Imports System.IO

Imports System.Linqg

Imports System.Windows.Forms
Imports Microsoft.VisualBasic
Imports OneStream.Finance.Database
Imports OneStream.Finance.Engine
Imports OneStream.Shared.Common
Imports OneStream.Shared.Database
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Imports OneStream.Shared.Engine
Imports OneStream.Shared.Wcf
Imports OneStream.Stage.Database
Imports OneStream.Stage.Engine

Namespace OneStream.BusinessRule.Extender.SIC_BulkCopyExample
Public Class MainClass

Public Function Main(ByVal si As SessionInfo, ByVal globals As BRGlobals, ByVal api

As Object, ByVal args As ExtenderArgs) As Object
Try
SIC Gateway name
Dim sicGatewayName As String = "jl-db-achgal-gateway"
' SIC remote rule

Dim sicRemoteRule As String = "SIC Functions"
' SIC remote rule function
Dim sicRemoteRuleFunction As String = "RunOperation"
' Create and populate DataTable
Dim dt As New DataTable()
dt.Columns.Add("Scenario", GetType(String))
dt.Columns.Add("Time", GetType(String))
dt.Columns.Add("Entity", GetType(String))
dt.Columns.Add("Account"”, GetType(String))
dt.Columns.Add("Amount", GetType(Double))
dt.Rows.Add("Actual”, "2023M3", "Houston Heights", "Net Sales", 100.25)
dt.Rows.Add("Actual™, "2023M3", "South Houston", "Net Sales", 1230.66)
' Compress data table before passing into remote business rule
Dim dtCompress As CompressionResult = CompressionHelper.CompressJsonObject
(Of DataTable)(si, dt, XFCompressionAlgorithm.DeflateStream)

Dim dtObj(2) As Object ' Create object to store arguments for remote business rule
dtObj(@) = dtCompress ' compressed datatable
dtObj(1) = "SIC_WriteBack" ' remote database table name
dtObj(2) = "RevenueMgmt" ' remote data source name
' Execute remote business rule to bulk copy to target table
Dim bulkRemoteResults As RemoteRequestResultDto
=BRApi.Utilities.ExecRemoteGatewayBusinessRule(si, sicRemoteRule,
dtObj, sicGatewayName,sicRemoteRuleFunction,String.Empty, False, 600)
' Get result status
If bulkRemoteResults.RemoteResultStatus <>
RemoteMessageResultType.RunOperationReturnObject Then ' Check if successful
' Failed, do something
BRAPi.ErrorLog.LogMessage(si,"Failed with status:" & bulkRemoteResults.
RemoteResultStatus.ToString)

End If
' Get returned message

Dim returnedMsg As String = CompressionHelper.InflateJsonObject(Of String)
(si,bulkRemoteResults.resultDataCompressed)
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BRAPi.ErrorLog.LogMessage(si,returnedMsg)

Return Nothing
Catch ex As Exception
Throw ErrorHandler.LogWrite(si, New XFException(si, ex))
End Try
End Function
End Class
End Namespace

The Extensibility Rule above calls the following Smart Integration Function:

Imports System

Imports System.Collections.Generic
Imports System.Data

Imports System.Data.Common

Imports System.Globalization
Imports System.IO

Imports System.Linqg

Imports System.Data.SqlClient
Imports OneStream.Shared.Common
Imports OneStreamGatewayService

Namespace OneStream.BusinessRule.SmartIntegrationFunction.SIC_Functions
Public Class MainClass
" Function to bulk copy a compressed data table to a SQL database table
Pass in compressed data table, database table name and data source name
Public Shared Function RunOperation(dtCompress As CompressionResult,tablename As String,
datasource As String) As String

Get SQL connection string
Dim connString As String = APILibrary.GetRemoteDataSourceConnection(datasource)

Inflate compressed datatable
Dim dt As DataTable = CompressionHelper.InflateJsonObject(Of DataTable)
(New SessionInfo,dtCompress)

If dt IsNot Nothing AndAlso dt.Rows.Count > © Then
' Check data table has been created and is populated

' Create sqgl connection to DWH
Using sqlTargetConn As SqlConnection = New SqlConnection(connString)

sqlTargetConn.Open ' Open connection
Using bulkCopy = New SqlBulkCopy(sqlTargetConn)

bulkCopy.DestinationTableName = tableName ' DWH table
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bulkCopy.BatchSize = 5000
bulkCopy.BulkCopyTimeout = 30

bulkCopy.WriteToServer(dt)
End Using
End Using
Else
Throw New Exception(“Problem uncompressing data in SIC gateway")
End If
Return $"{dt.Rows.Count} rows bulk inserted into table {tableName}"

End Function

End Class
End Namespace

Support for sFTP

Smart Integration Connector provides support for connecting to sFTP servers to send and retrieve
files. Perform the steps in the following sections to establish a connection and then send and
retrieve files.

NOTE: You must have an sFTP server available on a port. The port must be
allowed for inbound and outbound connections on the Local Gateway Server. For
this example, we have used port 22.

1. Login to OneStream.
2. Navigate to System > Administration > Smart Integration Connector.

3. Create a New Gateway and fill out all of the corresponding details for your Gateway and the
Gateway Server.

4. From Connection Type, select Direct Connection (e.g., SFTP, WebAPI).

5. For Bound Port at Gateway, enter 22.
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6. For Remote Gateway Host, enter the IP address or resolvable host name of the machine
where your SFTP server is located.

) Create New Gateway 0 x
MName northamerica_sftp

Description Morth America sFTP server

Gateway Server Morth_America v
Connection Type Direct Connection (e.g. SFTP, WebAPI) A

Bound Port at Gateway 22

Femote Gateway Host 172.168.3.4

Bound Port in OneStream | -1

Ok Cancel

7. For Bound Port in OneStream, enter -1 to automatically assign an un-used port number.
You can also specify your own port number by entering a value greater than 1024 and less
than 65535. It is recommended to use a higher value because it is less likely that number
will be in use as this port number must be globally unique across all applications hosted on
the OneStream servers.

8. Click OK.

9. Copy the Gateway to the OneStream Smart Integration Connector Local Gateway
Server Configuration Utility.

Example: Here is an example of how you can upload and download
files through an SFTP extensibility rule.

NOTE: You will need to add WinSCPnet.DLL to your business rule Referenced
Assemblies from the Properties tab in the business rule.
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Imports System

Imports System.Collections.Generic
Imports System.Data

Imports System.Data.Common

Imports System.Globalization
Imports System.IO

Imports System.Linqg

Imports System.Windows.Forms
Imports Microsoft.VisualBasic
Imports OneStream.Finance.Database
Imports OneStream.Finance.Engine
Imports OneStream.Shared.Common
Imports OneStream.Shared.Database
Imports OneStream.Shared.Engine
Imports OneStream.Shared.Wcf
Imports OneStream.Stage.Database
Imports OneStream.Stage.Engine
Imports WinSCP

Namespace OneStream.BusinessRule.Extender.SFTP_Example
Public Class MainClass
Public Function Main(ByVal si As SessionInfo, ByVal globals As BRGlobals, ByVal api
As Object, ByVal args As ExtenderArgs) As Object

Try
' Setup the objects to read Gateway Details from BRAPIs

Dim objGatewayDetails As GatewayDetails = BRApi.Utilities.GetGatewayConnectionInfo(si,
"WinSCP_Gateway")

Dim objRemoteRequestResultDto As RemoteRequestResultDto =
BRApi.Utilities.ExecRemoteGatewayBusinessRule(si, "SFTP_Password", Nothing, "rochester_
gateway",String.Empty, "SFTP_Password", False, 600)

' Setup session options
Dim sessionOptions As New SessionOptions
With sessionOptions

.Protocol = Protocol.Sftp

.HostName = "localhost" "HostName in this instance is in refrence to
OneStream and will always be localhost.

.UserName = "onestreamtest” 'SFTP server UserName

' Password = "FFEEidkokkn 'sFTP server Password

.Password = objRemoteRequestResultDto.ObjectResult This is the returned value
from the remote rule that obtains the customer controlled password
.PortNumber = objGatewayDetails.OneStreamPortNumber
'use BRAPI to populate Port Number and return the dynamically assigned value from OneStream
.SshHostKeyFingerprint = "*kkffsssrsiiiissshiiikitssris’ 5oy Host Key from sFTP
host

End With

Using session As New Session
Connect
session.Open(sessionOptions)

' Get the filepath
' BatchHarvest in this example is File Share / Applicaitons / GolfStream / Batch /
Harvest
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Dim fileUPPath As String = BRAPi.Utilities.GetFileShareFolder(si,
FileShareFolderTypes.BatchHarvest, Nothing)

Dim fileDNPath As String = BRAPi.Utilities.GetFileShareFolder(si,
FileShareFolderTypes.BatchHarvest, Nothing)

Dim transferOptions As New TransferOptions

transferOptions.TransferMode = TransferMode.Binary

Dim transferResult As TransferOperationResult

fileUPpath = fileUPPath & "\SFTP_TEST_UPLOAD.txt"

transferResult = session.PutFiles(fileUPpath, "/", False, transferOptions)

transferResult.Check()

fileDNpath = fileDNPath & "\SFTP_TEST_DOWNLOAD.txt"

transferResult = session.GetFiles("\SFTP_TEST DOWNLOAD.txt", fileDNpath, False,
transferOptions)

transferResult.Check()
End Using

Return Nothing

Catch ex As Exception
Throw ErrorHandler.LogWrite(si, New XFException(si, ex))
Return Nothing

End Try

End Function

End Class
End Namespace

Transferring Files from Local FileShare

You can use a Data Management job to move files Smart Integration Connector from a local
FileShare. To do this, you build an extender business rule and call it through a data management
job. This extender business rule will call a Smart Integration Function (remote function) and obtain
the results.

Step 1 - Setup the Remote Server / Remote Share

To get started, setup the Smart Integration Function:
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1. Navigate to Application > Tools > Business Rules.

2. Open the Smart Integration Function folder.

3. Create a new business rule (for example, TestFileRead) .

4. Copy and paste the following business rule code snippet.

using System;
using System.
.Data;
using System.

using System
using System

using System

Collections.Generic;

Data.Common;

I0;

.Ling;

.Globalization;
using System.

namespace OneStream.BusinessRule.SmartIntegrationFunction.TestFileRead

{

public class MainClass

{

public
{

}

public
{

}

public
{

byte[] RunOperation(string year)

string fname = @"c:\temp\hw_" + year + ".csv";
byte[] buffer = System.IO.File.ReadAllBytes(fname);
return buffer;

byte[] GetOtherFileData(string year)

string fname = @"c:\temp\zw_" + year + ".csv";
byte[] buffer = System.IO.File.ReadAllBytes(fname);
return buffer;

bool DeleteOldFileData(string year)
string fname = @"c:\temp\zw_" + year + "
try
{

System.IO.File.Delete(fname);

return true;

",
.csv';

}
catch (IOException)
{

return false;
}
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Step 2 - Pull file from Extender Business Rule

1. Navigate to Application > Tools > Business Rules.
2. Open the Extensibility Rules folder.
3. Create a new business rule (for example, ProcessRemoteFileData) .

4. Copy and paste the following business rule code snippet.

Imports System

Imports System.Data

Imports System.Data.Common

Imports System.IO

Imports System.Collections.Generic
Imports System.Globalization
Imports System.Ling

Imports Microsoft.VisualBasic
Imports System.Windows.Forms
Imports OneStream.Shared.Common
Imports OneStream.Shared.Wcf
Imports OneStream.Shared.Engine
Imports OneStream.Shared.Database
Imports OneStream.Stage.Engine
Imports OneStream.Stage.Database
Imports OneStream.Finance.Engine
Imports OneStream.Finance.Database

Namespace OneStream.BusinessRule.Extender.ProcessRemoteFileData
Public Class MainClass
Public Function Main(ByVal si As SessionInfo, ByVal globals As BRGlobals, ByVal api
As Object, ByVal args As ExtenderArgs) As Object
Try
Dim stepNumber As String = "1"

If (Not args.NameValuePairs Is Nothing) Then

If (args.NameValuePairs.Keys.Contains("step")) Then
stepNumber = args.NameValuePairs.Item("step")
End If
BRApi.ErrorLog.LogMessage(si, "File Processing Step: " & stepNumber)
End If

Select Case stepNumber
Case Is = "1"
GetData(si)

Return Nothing

Case Is = "2"
CleanupData(si)
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Return Nothing

End Select

Catch ex As Exception
Throw ErrorHandler.LogWrite(si, New XFException(si, ex))
End Try

Return Nothing
End Function

Public Sub CleanupData(ByVal si As SessionInfo)

Dim argTest(@) As Object
argTest(Q) = "2023"

Here we are telling it to specifically call
Dim objRemoteRequestResultDto As RemoteRequestResultDto =
BRApi.Utilities.ExecRemoteGatewayBusinessRule(si, "TestFileRead", argTest, "gateway-jasonl-
smartic", "DeleteOldFileData")
If (objRemoteRequestResultDto.RemoteResultStatus =
RemoteMessageResultType.RunOperationReturnObject) Then
' The delete method returns a true/false return type
Dim result As Boolean
' ObjectResultValue introduced in v7.4 to simplify obtaining the return
value from a method that doesn't return a
' Dataset/Datatable
result = objRemoteRequestResultDto.ObjectResultValue

Dim objRemoteRequestResultDtoCached As RemoteRequestResultDto =
BRApi.Utilities.ExecRemoteGatewayCachedBusinessRule(si, "TestFileReadCache", argTest,
"gateway-jasonl-smartic", String.Empty)

BRApi.ErrorLog.LogMessage(si, "File Deleted: " & result)
Else
If (Not (objRemoteRequestResultDto.remoteException Is Nothing)) Then
Throw ErrorHandler.LogWrite(si, New XFException(si,
objRemoteRequestResultDto.remoteException))
End If
End If

End Sub
Public Sub GetData(ByVal si As SessionInfo)

Demonstrating how to pass parameters

We create an object array that matches the number of parameters

To the remote function. 1In this case, we have 1 parameter that is a string
Dim argTest(®) As Object

argTest(9) = "2023"
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This is where you can allow caching of the remote function. We are passing
in true at the end to force the cache to be updated

' We are also allowing the function to run for 90 seconds.
String.empty means this will look for a remote function/method called

"RunOperation"

Dim objRemoteRequestResultDto As RemoteRequestResultDto =
BRApi.Utilities.ExecRemoteGatewayBusinessRule(si, "TestFileRead", argTest,
"ryantestconnection2", String.Empty,"TestFileRead", True, 90)

If (objRemoteRequestResultDto.RemoteResultStatus =

RemoteMessageResultType.RunOperationReturnObject) Then

Dim bytesFromFile As Byte()

bytesFromFile = objRemoteRequestResultDto.ObjectResultValue

Dim valueAsString As String = System.Text.Encoding.UTF8.GetString
(bytesFromFile)

Return valueAsString

bytesFromFile = Convert.FromBase64String
(objRemoteRequestResultDto.ObjectResultValue)

'bytesFromFile = objRemoteRequestResultDto.ObjectResultValue

Dim valueAsString As String = System.Text.Encoding.UTF8.GetString

(bytesFromFile)
' Do something with the files here....

BRApi.ErrorLog.LogMessage(si, "File Contents: " & Left(valueAsString,10))
' We are saving the file into the OneStream Share here
This is an option to allow other OneStream functions to process the data

'Dim groupFolderPath As String =
FileShareFolderHelper.GetGroupsFolderForApp(si, True, AppServerConfig.GetSettings
(si).FileShareRootFolder, si.AppToken.AppName)

Dim groupFolderPath As String = BRAPi.Utilities.GetFileShareFolder(si,
FileShareFolderTypes.BatchHarvest, Nothing)

Using sw As StreamWriter = New StreamWriter(groupFolderPath &

"\outputfile.csv")
sw.Write(valueAsString)
sw.Close()
End Using
Else
If (Not (objRemoteRequestResultDto.remoteException Is Nothing)) Then

Throw ErrorHandler.LogWrite(si, New XFException(si,
objRemoteRequestResultDto.remoteException))

End If
End If
End Sub

End Class
End Namespace
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5. Test your Extender Business Rule via the Execute Extender button in the toolbar.

SR

Execute Extender

Step 3 - Automate from Data Management / Task
Scheduler

After the Extensibility Rule has been created and tested you can automate from a Data
Management Job and associate Task Schedule. See Task Scheduler for more information.

1. Navigate to Application > Tools > Data Management.
2. Create a new Data Management Group.

3. Enterthe businessrule.

4. Setthe first Parameter to step=1.

5. Setthe Parameters to step=2.

6. Create associated Task Schedule to run the Data Management job.

Support for DLL Migration

Per OneStream Platform Versions 8.0 and above, all customer supplied DLLs will now be
referenced via Smart Integration Connector. In order to use, copy the DLL to the Reference
BusinessRule AssemblyFolder in the SIC Local Gateway Server Utility and reference this DLL
within your Smart Integration Function. Refer to Reference BusinessRule AssemblyFolder section
for additional setup details.

To verify the Reference BusinessRule AssemblyFolder path:
1. Open the OneStream Local Gateway Configuration and Run as Administrator.

2. Navigate to Local Application Data Settings and click the ellipses.
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B Additional Settings

Local Application Data Settings (Detail)

Log Settings (Detail)

3. Enter the file path under Referenced BusinessRule AssemblyFolder.

Maximum Records to Return when Paging 1000000
Maximum Records to Return 5000000
Row Count to Begin Paging Operations 1000000
Settings (Collection)

Default is blank, which defaults to the SIC Install Folder.
4. Click OK.

See the SAP example below for this process in use. Additionally, refer to Smart Integration
Connector Settings for more information on these fields.

Support for ERPConnect (SAP)

As an alternative to creating a Local Gateway Connection to your SAP database, you can connect
to SAP using 3rd party DLLs such as ERPConnect##.dll. ERPConnect##.dll can be referenced
using a Smart Integration Connector Remote business rule. Although ERPConnect45.dll enabling
connection to SAP systems is no longer available in Smart Integration Connector 8.0, a newer
version ERPConnectStandard20.dll is available through the download "DLL Packages" from the
Platform page of the Solution Exchange. ERPConnect requires additional libraries to be obtained
from SAP as well which can reside in the same reference assembly folder as ERPConnect.

To get started:

1. From the Solution Exchange, download ERPConnectStandard20.dll file to your Referenced
BusinessRule AssemblyFolder.

2. Install the required Visual C++ 2013 Runtime.
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3. From SAP, download and copy SAP NetWeaver RFC Library DLL (sapnwrfc.dll) and
associated icudt50.dll, icuin50.dIl, icuuc50.dll to your Referenced BusinessRule
AssemblyFolder. Refer to the Theobald Software ERPConnect Requirements for additional
information.

4. Modify your business rules to use the ERPConnectStandard20.dlI.
5. Navigate to Application > Tools > Business Rules.

6. Expand the Smart Integration Function list.

7. Create a new Smart Integration Function or select an existing one.

8. Click the Properties tab.

B General
Mame SIC_SAP_TEST
Type Smart Integration Function
Language Type Visual Basic
Referenced Assemblies ! ERPConnectStandard20.dll
s Encrypted False
B Security
Access Group Administrators @
Maintenance Group Administrators 2]

1. Enter ERPConnectStandard20.dll in the Referenced Assemblies field the Smart
Integration Connector Gateway server will attempt to locate this DLL in the folder defined
previously defined Referenced BusinessRule AssemblyFolder.

2. Add Imports for ERPConnect and ERPConnect.Utils.
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Filter ® #+ W= 2|1V e

& api 1 FHImports System
Imports System.Data

& args Imports System.Data.Common

b S5 ERADI Imports System.I0
. Imports System.Collections.Generic

P & Snippets :[n:;lorts. S;:;tem.ﬁlohalization
Imports System.Ling
Imports Microsoft.visualBasic
E Imports ERPConnect
18 | Imports ERPConnect.Utils

PR R

11
12 ENamespace OneStream.BusinessRule.SmartIntegrationFunction.SAPDemo

13 | [ Public Class MainClass

14

15 = Public Shared Function RunOperation() As DataTable

16 "https://kb.theobald-software. com/sap/how-to-check-the-accessibility-to-a-sap-system
17 Dim r3Conn = Mew R3Connection(”endpoint~™, "@@", "7, "7, "EN", "E8@")

18 r3Conn.Open( )

19 Dim r3Table As New ReadTable(r3Conn)

28 r3Table.TableName = "BSEG"

21

22 r3table.SetCustomFunctionName("Z_XTRACT_IS_TABLE™)

23 r3Table.AddCriteria{"GIAHR = 2816™)

‘Query the table
r3Table.Run()
Return r3Table.result

% | End Function
23 End Class

38 | End Namespace

31

3. Verify you can compile the function on your Gateway.

You are now ready to add your custom code.
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Business Rules

The Smart Integration Connector Capabilities introduce additional business rule APIs (BR APIs)
to allow for execution and management of remote business rules inside the context of the Smart
Integration Connector gateway. These rules are transported using https to the Smart Integration
Connector local gateway, compiled locally, executed, and the results returned to the caller for
further processing. They provide a mechanism for complex drill backs, data processing scenarios
or to invoke remote webAPIs hosted in your network.

I NOTE: Gateways must have a local data source defined to invoke remote business
rules.

There are two ways business rules can be used with the Smart Integration Connector Gateway:

» OneStream BRAPIs interact with a specific local gateway and run on OneStream
application servers.

* Business rules that reference DLLs that are only accessible by the Local Gateway Server.
These BRs are compiled and executed on the local gateway (Remote Business Rules
when creating them in the Windows Desktop Client).

In these scenarios, the local gateway must have the allowRemoteCodeExec setting configured to
True to enable remote execution.

The BR APIs are outlined below:

ExecRemoteGatewayRequest

ExecRemoteGatewayCachedBusinessRule

ExecRemoteGatewayJob

ExecRemoteGatewayBusinessRule

GetRemoteDataSourceConnection

GetRemoteGatewayJobStatus
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Business Rules

GetSmartintegrationConfigValue

GetGatewayConnectionInfo

Incompatible Business Rules

ExecRemoteGatewayRequest

Initiates a request to a local gateway as specified in the remote request object. This request is
dispatched to the Smart Integration Connector local gateway connection data source with the
specified command remote invoked.

NOTE: This method is used for request and response type interactions to a remote
endpoint that runs for three or less minutes. The default execution timeout is 90
seconds and can be overridden by setting the CommandTimeout property on the
RemoteRequestDTO instance provided.

Parameter details:

+ RemoteRequestDTO: Remote request object populated with the remote command and
endpoint

+ Returns: RemoteRequestResultDto - Result of execution including the status and any
exceptions which may have occurred on the remote endpoint

Following is an example connector business rule that would run on the OneStream application
server sending a remote request and block of code to a Local Gateway Connection:

Dim objxfRemoteRequestResultDto As RemoteRequestResultDto
Dim objxfRemoteRequest As New RemoteCodeRequestDto

objxfRemoteRequest.connectionType = RemoteCommandType.RemoteCodeExec

objxfRemoteRequest.gatewayHostforRequest = "testconnection”

Dim strCode As String

strCode = "using System;...."

objxfRemoteRequest.LanguageType = RemoteCodelLanguageType.CSHARP
objxfRemoteRequest.remoteCodeBlock = strCode
objxfRemoteRequestResultDto=BRApi.Utilities.ExecRemoteGatewayRequest(objxfRemoteRequest)
Dim xfDT = New XFDataTable(si,objxfRemoteRequestResultDto.resultSet,Nothing,1000)
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This BR API can also be used to invoke arbitrary SQL commands against a Smart Integration

Connector local gateway connection data source at your site:

Dim drillBackInfo As New DrillBackResultInfo

Dim drillBackSQL As String = "SELECT CustName, InvDesc, BomCode, UnitPrice, Units, Amount,
'BomDetail’' As DrillTypeCode FROM InvoiceMaterialDetail WHERE

(InvYear = 2022) And (InvMonth = 'M3') And (PlantCode = '"H200') And (InvNo = 'I1-H200-AH2347-
2022M3")

And (ProdModel = 'P-Boy') And (DestinationCode = '1230') And (CustID = 'AH2347')ORDER BY BomCode"

Dim objxfRemoteRequestResultDto As RemoteRequestResultDto

Dim objxfRemoteRequest As New RemoteRequestDto

' Indicate this is a remote SQL command request
objxfRemoteRequest.connectionType = RemoteCommandType.SQLCommand
objxfRemoteRequest.GatewayRemoteDBConnection = "RevenueMgmt™" '
remote endpoint

objxfRemoteRequest.gatewayHostforRequest = "testconnection” ' Name of the remote host to pass to

objxfRemoteRequest.RemoteCommand = drillBackSQL
objxfRemoteRequestResultDto=BRApi.Utilities.ExecRemoteGatewayRequest(objxfRemoteRequest)
Evaulate the results to determine if it was successful
If (objxfRemoteRequestResultDto.RemoteResultStatus = RemoteMessageResultType.Success) Then
Dim xfDT = New XFDataTable(si,objxfRemoteRequestResultDto.ResultSet,Nothing,1000)
drillBackInfo.DisplayType = ConnectorDrillBackDisplayTypes.DataGrid
drillBackInfo.DataTable = xfDT
Return drillBackInfo
Else
drillbackinfo.TextMessage = "Not Successful"
drillBackInfo.DisplayType = ConnectorDrillBackDisplayTypes.TextMessage
Return drillBackInfo
End If

Remote function returning a datatable (VB.NET) without parameters:

'Here we are telling it to specifically call a remote Smart Integration Function called
'GetDataFromDB at SIC Gateway called TestConnection with a method called RunOperation
Dim objRemoteRequestResultDto As RemoteRequestResultDto =
BRApi.Utilities.ExecRemoteGatewayBusinessRule(si, "GetDataFromDB", Nothing, " TestConnection",
"RunOperation™)
If (objRemoteRequestResultDto.RemoteResultStatus = RemoteMessageResultType.Success) Then
If (objRemoteRequestResultDto.ResultType = RemoteResultType.DataTable) Then
BRApi.ErrorLog.LogMessage(si, "Data Returned: " &
objRemoteRequestResultDto.ResultSet.Rows.Count)
End If

Else
If (Not (objRemoteRequestResultDto.remoteException Is Nothing)) Then
Throw ErrorHandler.LogWrite(si, New XFException(si,
objRemoteRequestResultDto.remoteException))
End If
End If

Name of the connection defined in the
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ExecRemoteGatewayCachedBusinessRule

When a cache flag and key is provided to the ExecRemoteGatewayBusinessRule BR API, this
method is used to invoke a previously cached method. This is intended to be used for high-
frequency remote business rules to avoid the performance impact of recompiling a remote
method on each invocation.

NOTE: Requires allowRemoteCodeExec = True on Smart Integration Connector
local gateway. If the previously cached method is not invoked after 60 minutes, the
remote cached method is purged.

Parameter details:
« si: SessionInfo object used to create connection objects
» cachedFunctionKey: Key of previously cached remote function to invoke

» functionArguments: Array of objects aligning to function / method parameters. Null /
Nothing if there are none required

* remoteHost: Name of remote host to invoke operation. (Smart Integration Connector Local
Gateway Name)

» executionTimeOut: Timeout (in seconds) on the remote job

* Returns: RemoteRequestResultDto - Result of execution including the status and any
exceptions which may have occurred on the remote endpoint

Here is the rule in C#:

try

RemoteRequestResultDto objRemoteRequestResultDto = BRApi.Utilities.ExecRemoteGatewayBusinessRule
(si, "GetDataFromDB", null, "TestConnection", "RunOperation", " GetDataFromDBCached ", false, 990);

if (objRemoteRequestResultDto.RemoteResultStatus == RemoteMessageResultType.Success
&& objRemoteRequestResultDto.ResultSet != null
&& objRemoteRequestResultDto.ResultType == RemoteResultType.DataTable)

{

BRApi.ErrorLog.LogMessage(si, "Data Returned - Rows:" +
objRemoteRequestResultDto.ResultSet.Rows.Count);

}

Smart Integration Connector Guide 70



Business Rules

else

if (objRemoteRequestResultDto.RemoteException != null)

{

throw ErrorHandler.LogWrite(si, new XFException(si, objRemoteRequestResultDto.RemoteException));

}

else

{

BRApi.ErrorLog.LogMessage(si, "Remote Smart Integration Function Succeeded - no data/datatable
returned");

}
}

// Subsequent invocations of the remote BR can be run by specifying the endpoint and the cached
key name

RemoteRequestResultDto objRemoteRequestResultDtoCached =
BRApi.Utilities.ExecRemoteGatewayCachedBusinessRule(si, " GetDataFromDBCached",null, "
TestConnection ", 90);

return null;

}
catch (Exception ex)
{
throw ErrorHandler.LogWrite(si, new XFException(si, ex));

Here is the rule in VB.NET:

Dim argTest(@) As Object
argTest(0) = "2023"

'Here we are telling it to specifically call a remote Smart Integration function called

'TestFileread at a remote gateway called TestConnection and caching the compiled

'result as a key called TestFileReadCache with a 90 second timeout

Dim objRemoteRequestResultDto As RemoteRequestResultDto =
BRApi.Utilities.ExecRemoteGatewayBusinessRule(si, "TestFileRead", argTest,
"DeleteOldFileData","TestFileReadCache", false, 90)

If (objRemoteRequestResultDto.RemoteResultStatus =
RemoteMessageResultType.RunOperationReturnObject) Then

n "

TestConnection ",

'The delete method returns a true/false return type
Dim result As Boolean
' ObjectResultValue introduced in v7.4 to simplify obtaining the return value from a method that
doesn't return a
' Dataset/Datatable
result = objRemoteRequestResultDto.ObjectResultValue
' Here we are invoking a compiled/cached method at a remote gateway called
TestConnection using the key of TestFilereadCache with a 90 second timeout.
Dim objRemoteRequestResultDtoCached As RemoteRequestResultDto =
BRApi.Utilities.ExecRemoteGatewayCachedBusinessRule(si, "TestFileReadCache", argTest,
TestConnection ", 90)

"
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BRApi.ErrorLog.LogMessage(si, "File Deleted: " & result)
Else
If (Not (objRemoteRequestResultDto.remoteException Is Nothing)) Then
Throw ErrorHandler.LogWrite(si, New XFException(si,
objRemoteRequestResultDto.remoteException))
End If
End If

ExecRemoteGatewayJob

There may be instances where a remote operation on the Smart Integration Connector Local
Gateway host would need to process and assemble data that may take several minutes to run. In
this situation, you could use this BR API to queue and run a remote business rule in an
asynchronous manner where the remote Smart Integration Connector Local Gateway host
returns a Job ID (GUID) that can later be used to obtain the job’s status or the results if the job is
complete. When invoking this method, if the RemoteMessageResultStatus is returned as
JobRunning (as shown in the example below), the RequestJoblID is populated with the ID of the
queued job that can later be used to obtain status.

NOTE: Requires allowRemoteCodeExec = True on Smart Integration Connector
Local Gateway. There is a defined default limit of 30 minutes for remote jobs to
execute before the job is cancelled, and an overloaded version of
ExecremoteGatewayJob exists allowing the timeout to be provided, but can never
exceed 4 hours. This is not configurable and if this timeout is reached, the status
returned shows the timeout. If the result is not obtained within five minutes after the
job completes (using the GetRemoteGatewayJobStatus BR API), the remote
results are purged to ensure that result objects reclaim server memory on the Smart
Integration Service host.

Here is a basic overview of invoking a remote job and displaying the returned remote Job ID in
VB.NET.

NOTE: This is required to call back into GetRemoteJobStatus with the returned ID
to obtain the result:

Dim drillBackInfo As New DrillBackResultInfo
Dim argInt As New XFSimpleObject(12)

argInt.Int32Value = 12
Dim argTest(1) As Object
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100
"test"

argTest(9)
argTest(1)

Invoking a OneStream Business Rule as a remote job
Dim objRemoteRequestResultDto As RemoteRequestResultDto = BRApi.Utilities.ExecRemoteGatewayJob(si,
"TestLongRunning", argTest, "ryantestconnection",String.Empty)
If (objRemoteRequestResultDto.RemoteResultStatus = RemoteMessageResultType.JobRunning) Then
drillbackinfo.TextMessage = "Done " & objRemoteRequestResultDto.RequestJobID.ToString()
drillBackInfo.DisplayType = ConnectorDrillBackDisplayTypes.TextMessage
Return drillBackInfo
End If

Here is the rule in VB.NET to invoke a job, obtain the job ID, and 'poll' until completion:

Try
Dim jobID As Guid
¢ Invoking a long-running Job with a Smart Integration Function called GetDataFromDB on SIC Gateway
called testConneciton
Dim objRemoteRequestResultDto As RemoteRequestResultDto = BRApi.Utilities.ExecRemoteGatewayJob
(si, "GetDataFromDB", Nothing, "TestConnection",String.Empty)
" If Successful, the status is retuned indicating the job is running with the job ID - Use this
ID to interrogate if the job is compleed.
If (objRemoteRequestResultDto.RemoteResultStatus = RemoteMessageResultType.JobRunning)
Then
jobID = objRemoteRequestResultDto.RequestJobID
BRApi.ErrorLog.LogMessage(si, "Remote Job Queued and Running - JobID: " & jobID.ToString())
' Example waiting 20 seconds for job to complete
For loopControl = @ To 10
System.Threading.Thread.Sleep(2000)
Dim objJobStatus As RemotelobStatusResultDto = BRApi.Utilities.GetRemoteGatewayJobStatus(si,
JobID, " TestConnection ")

If (objJlobStatus.RemotelobState = RemoteJobState.Running)
BRApi.ErrorLog.LogMessage(si, "Remote Job Still running - JobID: " & jobID.ToString())
Else If (objJobStatus.RemotelobState = RemotelobState.Completed)
' Checking the return type from the remote job
If (Not objJobStatus.RemoteJobResult.ResultSet Is Nothing) Then
Dim xfDT = New XFDataTable(si,objJobStatus.RemoteJobResult.ResultSet,Nothing,1000)
BRApi.ErrorLog.LogMessage(si, "Remote Job Completed - Datatable Returned - JobID: " &
jobID.ToString())
Return Nothing
Else If (Not objJobStatus.RemotelobResult.ResultDataSet Is Nothing) Then
Dim xfDT = New XFDataTable(si,objJobStatus.RemoteJobResult.ResultDataSet.Tables
(0),Nothing,1000)
BRApi.ErrorLog.LogMessage(si, "Remote Job Completed - Dataset Returned - JobID: " &
jobID.ToString())
Return Nothing
Else If (Not objJobStatus.RemoteJobResult.ObjectResultValue Is Nothing) Then
BRApi.ErrorLog.LogMessage(si, "Remote Job Completed - Object Returned - JobID:
" & jobID.ToString())
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Return Nothing
End If

Else If (objJobStatus.RemotelobState = RemoteJobState.JobNotFound)
BRApi.ErrorLog.LogMessage(si, "Remote Job Not Found - JobID: " & jobID.ToString())
Return Nothing

Else If (objJobStatus.RemoteJobState = RemoteJobState.RequestTimeOut)

BRApi.ErrorLog.LogMessage(si, "Remote Job Timed Out - JobID: " & jobID.ToString())
Return Nothing
Else If (objRemoteRequestResultDto.RemoteResultStatus = RemoteMessageResultType.Exception)

BRApi.ErrorLog.LogMessage(si, "Exception During Exeuction of Job: " &
objRemoteRequestResultDto.RemoteException.ToString())
End If
Next
Else

Exception occurred immediately during compile/initial run

If (objRemoteRequestResultDto.RemoteResultStatus = RemoteMessageResultType.Exception)
BRApi.ErrorLog.LogMessage(si, "Exception Executing Job: " &

objRemoteRequestResultDto.RemoteException.ToString())

Else
BRApi.ErrorLog.LogMessage(si, "General Job Execution Error - State: " &
objRemoteRequestResultDto.RemoteResultStatus.ToString())
End If
End If

Return Nothing
Catch ex As Exception
Throw ErrorHandler.LogWrite(si, New XFException(si, ex))
End Try

Here is the rule in C# to invoke a job, obtain the job ID, and 'poll' until completion:

try
{

Guid jobID;

RemoteRequestResultDto objRemoteRequestResultDto = BRApi.Utilities.ExecRemoteGatewayJob(si,
"GetDataFromDB", null, " TestConnection ",string.Empty);

if (objRemoteRequestResultDto.RemoteResultStatus == RemoteMessageResultType.JobRunning)

{

jobID = objRemoteRequestResultDto.Request]obID;
BRApi.ErrorLog.LogMessage(si, "Remote Job Queued and Running - JobID: " + jobID.ToString());

// Example waiting 20 seconds for job to complete

for (int loopControl=0; loopControl<=10; loopControl++)
{
System.Threading.Thread.Sleep(2000);

RemoteJobStatusResultDto objJobStatus = BRApi.Utilities.GetRemoteGatewayJobStatus(si,
jobID, " TestConnection");

if (objJobStatus.RemotelobState == RemoteJobState.Running)

{
BRApi.ErrorLog.LogMessage(si, "Remote Job Still running - JobID: " + jobID.ToString());
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}
else if (objJobStatus.RemoteJobState == RemoteJobState.Completed)

{
// Checking the return type from the remote job
if (objJobStatus.RemoteJobResult.ResultSet != null)

{
XFDataTable xfDT = new XFDataTable(si,objJobStatus.RemoteJobResult.ResultSet,null,1000);

BRApi.ErrorLog.LogMessage(si, "Remote Job Completed - Datatable Returned - JobID: " +
jobID.ToString());

return null;

else if (objJlobStatus.RemoteJobResult.ResultDataSet != null)
{
XFDataTable xfDT = new XFDataTable
(si,objJobStatus.RemoteJobResult.ResultDataSet.Tables[0],null,1000);
BRApi.ErrorLog.LogMessage(si, "Remote Job Completed - Dataset Returned - JobID:
" + jobID.ToString());
return null;

else if (objJobStatus.RemoteJobResult.ObjectResultValue !=null)

{
BRApi.ErrorLog.LogMessage(si, "Remote Job Completed - Object Returned -

JobID: " + jobID.ToString());
return null;

}

{
BRApi.ErrorLog.LogMessage(si, "Remote Job Not Found - JobID: " +

else if (objJobStatus.RemoteJobState == RemoteJobState.JobNotFound)

jobID.ToString());
return null;
}
else if (objJlobStatus.RemoteJobState == RemoteJobState.RequestTimeOut)
{
BRApi.ErrorLog.LogMessage(si, "Remote Job Timed Out - JobID: " + jobID.ToString());
return null;
}
else if (objRemoteRequestResultDto.RemoteResultStatus ==
RemoteMessageResultType.Exception)
{
BRApi.ErrorLog.LogMessage(si, "Exception During Exeuction of Job: "+
objRemoteRequestResultDto.RemoteException.ToString());
return null;

}
}
}
// End for loop
}
else
{

// Exception occurring immediately during compile/initial run
if (objRemoteRequestResultDto.RemoteResultStatus == RemoteMessageResultType.Exception)

BRApi.ErrorLog.LogMessage(si, "Exception Executing Job: " +
objRemoteRequestResultDto.RemoteException.ToString());
else
BRApi.ErrorLog.LogMessage(si, "General Job Execution Error - State: " +

objRemoteRequestResultDto.RemoteResultStatus.ToString());
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return null;

}
}

catch (Exception ex)

{

throw ErrorHandler.LogWrite(si, new XFException(si, ex));

}

return null;

ExecRemoteGatewayBusinessRule

This is a core BR API that can be used to remotely invoke Smart Integration functions on a
specified remote Smart Integration Connector Local Gateway host. The Smart Integration
Connector Local Gateway must have allowRemoteCodeExec set to True for this BR API to invoke
an operation successfully, otherwise the Smart Integration Connector Local Gateway host returns
a result indicating that remote code execution is disabled.

This method takes a previously authored Smart Integration function, written in VB.NET or C#, in
the OneStream application and passes it to the remote host for execution. With this BR API, it is
expected that remote calls should take no more than 2-3 minutes to return a result to the caller as
this BR APl will block until a result is returned. If longer running or sync operations are needed,
consider using the execRemoteGatewayJob BR API.

I NOTE: Requires allowRemoteCodeExec = True on Smart Integration Service
Parameter details:
 si: SessionInfo object used to create connection objects

» brName: Name of the locally defined (within the OneStream Application scope) Smart
Integration function

» functionArguments: Array of objects aligning to function / method parameters. Null /
Nothing if there are none required.

» remoteHost: Name of remote host to invoke operation. (Smart Integration Connector name)

Smart Integration Connector Guide 76



Business Rules

 functionName: Name of the function in the Smart Integration function to invoke. If null or
empty, a function/method with the name RunOperation is expected to exist within the
authored code.

» (Optional) cachedFunctionKey: Name used to cache the remote function to avoid
recompiling the function on a subsequent call. This is optional and if missing or null the
function will not be cached.

» (Optional) forceCacheUpdate: Option indicating if a previously cached function should be
replaced with this version. When true, and an existing function is found with a name
specified in the cachedFunctionKey parameter, the BR is recompiled and recached. This is
useful for situations where a remote function is cached and a change was made.

» executionTimeOut: Timeout (in seconds) on the remote job (In 7.4, this is now an optional
parameter and defaults to 90 seconds if the parameter is missing.)

Here is a C# drill-back example:

DrillBackResultInfo drillBackInfo = new DrillBackResultInfo();

DataTable dtf = BRApi.Utilities.ExecRemoteGatewayBusinessRule(si, "SAP_Test", null, "gateway-SAP_
Europe",string.Empty).ResultSet;

var xfDT = new XFDataTable(si, dtf, null, 1000);

drillBackInfo.DataTable = xfDT;

drillBackInfo.DisplayType = ConnectorDrillBackDisplayTypes.DataGrid; return drillBackInfo;

Here is a VB.NETdrill-back example that invokes a remote business rule accepting 2 parameters:

Dim drillBackInfo As New DrillBackResultInfo
Dim argTest(l) As Object

argTest(0) 12

argTest(1) "test"

Dim objRemoteRequestResultDto As RemoteRequestResultDto =
BRApi.Utilities.ExecRemoteGatewayBusinessRule
(si, "TestValueTypeParam", argTest, "testConnection","RunOperation2")

If (objRemoteRequestResultDto.RemoteResultStatus = RemoteMessageResultType.RunOperationReturnObject)
Then

Dim returnval As System.Collections.ArraylList returnval =
objRemoteRequestResultDto.ObjectResultValue

Smart Integration Connector Guide 77



Business Rules

'Simple demonstration without error checking to look at the first element of the arraylist
drillbackinfo.TextMessage =

"Completed! " & returnval(®@).ToString() drillBackInfo.DisplayType =
ConnectorDrillBackDisplayTypes.TextMessage

Return drillBackInfo
Else If (objRemoteRequestResultDto.RemoteResultStatus = RemoteMessageResultType.Success)

' Demonstrating a 'pattern' whereby the caller can verify what the type is that's returned and
handle properly.
Dim xfDT = New XFDataTable(si,objRemoteRequestResultDto.resultSet,Nothing,1000)
drillBackInfo.DataTable = xfDT
drillBackInfo.DisplayType = ConnectorDrillBackDisplayTypes.DataGrid
Return drillBackInfo
Else If (Not (objRemoteRequestResultDto.remoteException Is Nothing)) Then
Throw ErrorHandler.LogWrite(si, New XFException(si,objRemoteRequestResultDto.remoteException))
End If
Return Nothing
End If

Below is a TestFileRead Remote Business Rule function in C# Referenced by Examples Below:

using System;

using System.Collections.Generic;
using System.Data;

using System.Data.Common;

using System.Globalization;

using System.IO;

using System.Ling;

using System.Data.SqlClient;
using OneStreamGatewayService;

namespace OneStream.BusinessRule.SmartIntegrationFunction.GetDataFromDB

{
public class MainClass
{
public DataTable RunOperation()
{
DataTable dataTableResults = new DataTable();
string connectionString, sql;
// The API Below is only available in 7.4 and allows the ability to
// Obtain a remotely defined connection string.
connectionString = APILibrary.GetRemoteDataSourceConnection("RevenueMgmt™);
SqlConnection connj;
conn = new SqlConnection(connectionStringconn.Open();
sql = "Select * FROM InvoiceMaterialDetail";
SqlCommand cmd = new SqlCommand(sql, conn);
var dbreader = cmd.ExecuteReader();
dataTableResults.Load(dbreader);
return dataTableResults;
¥
}
}
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Remote function returning a scalar value (VB.NET) or object with parameters:

Dim argTest(®) As Object
argTest(9) = "2023"

'Here we are telling it to specifically call a remote Smart Integration Function called
TestFileRead at SIC Gateway

'called TestConnection with a method called DeleteOldFileData

Dim objRemoteRequestResultDto As

RemoteRequestResultDto = BRApi.Utilities.ExecRemoteGatewayBusinessRule(si, "TestFileRead",
argTest, "TestConnection", "DeleteOldFileData")

If (objRemoteRequestResultDto.RemoteResultStatus =
RemoteMessageResultType.RunOperationReturnObject) Then

'The delete method returns a true/false return type

Dim result As Boolean
'ObjectResultValue introduced in v7.4 to simplify obtaining the return
'value from a method that doesn't return a Dataset/Datatable

result = objRemoteRequestResultDto.ObjectResultValue

'"Previous to v7.4, The result was returned in a compressed format and it is required that
'InfateJsonObject was invoked

'result = CompressionHelper.InflateJsonObject(Of Object)
'(si,objRemoteRequestResultDto.resultDataCompressed)

BRApi.ErrorLog.LogMessage(si, "File Deleted: " & result)
Else
If (Not (objRemoteRequestResultDto.remoteException Is Nothing)) Then
Throw ErrorHandler.LogWrite(si, New XFException
(si, objRemoteRequestResultDto.remoteException))
End If
End if

Remote function returning a scalar type/object (C#):

try
{
object[] argTest = new object[1];
argTest[0] = "2023";

'Here we are telling it to specifically call a remote Smart Integration Function called
TestFileRead at SIC Gateway

'called TestConnection with a method called DeleteOldFileData

RemoteRequestResultDto objRemoteRequestResultDto =
BRApi.Utilities.ExecRemoteGatewayBusinessRule(si, "TestFileRead", argTest, " TestConnection",
"DeleteOldFileData");

if (objRemoteRequestResultDto.RemoteResultStatus ==
RemoteMessageResultType.RunOperationReturnObject
&& objRemoteRequestResultDto.ObjectResultValue != null)

bool result;
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if (bool.TryParse(objRemoteRequestResultDto.ObjectResultValue.ToString(), out result))
BRApi.ErrorLog.LogMessage(si, "File Deleted: "

else

BRApi.ErrorLog.LogMessage(si, "Returned a non-boolean value");

+ result.ToString());

else
if (objRemoteRequestResultDto.RemoteException != null)
throw ErrorHandler.LogWrite(si, new XFException(si,
objRemoteRequestResultDto.RemoteException));

return null;
catch (Exception ex)
throw ErrorHandler.LogWrite(si, new XFException(si, ex))
End Try

Remote function returning a datatable (C#):

try
{
// Here we are telling it to specifically call a remote Smart Integration Function called
GetDataFromDB at SIC Gateway called TestConnection with a method called RunOperation
RemoteRequestResultDto objRemoteRequestResultDto = BRApi.Utilities.ExecRemoteGatewayBusinessRule
(si, "GetDataFromDB", null, "TestConnection", "RunOperation");

if (objRemoteRequestResultDto.RemoteResultStatus == RemoteMessageResultType.Success
&& objRemoteRequestResultDto.ResultSet != null
&& objRemoteRequestResultDto.ResultType == RemoteResultType.DataTable)

{

BRApi.ErrorLog.LogMessage(si, "Data Returned - Rows:" +
objRemoteRequestResultDto.ResultSet.Rows.Count);

}

else
if (objRemoteRequestResultDto.RemoteException != null)

{
throw ErrorHandler.LogWrite(si, new XFException(si,
objRemoteRequestResultDto.RemoteException));

}

{
BRApi.ErrorLog.LogMessage(si, "Remote Smart Integration Function Succeeded - no
data/datatable returned");
}
}

else

return null;

}

catch (Exception ex)

{

throw ErrorHandler.LogWrite(si, new XFException(si, ex));

}
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GetRemoteDataSourceConnection

This remote business rule will return the connection string associated with a Local Gateway
Configuration Data Source.

NOTE: Requires allowRemoteCodeExec = True on Smart Integration Local
Gateway.

Parameter details:
» Data Source: The name of the Local Gateway Configuration Data Source.

Here is the rule in VB.NET :

Imports System
Imports System.Collections.Generic
Imports System.Data
Imports System.Data.Common
Imports System.Globalization
Imports System.IO
Imports System.Linqg
Namespace OneStream.BusinessRule.SmartIntegrationFunction.GetRemoteDataSource_VB
Public Class MainClass
Public Shared Function RunOperation() As DataTable
Dim dataTableResults As New DataTable

Dim connectionString As String =
OneStreamGatewayService.APILibrary.GetRemoteDataSourceConnection("Sales_Datal");

Dim conn As SqlConnection = New SqlConnection(connectionString)

Return dataTableResults
End Function
End Class
End Namespace

using System;

using System.Collections.Generic;
using System.Data;

using System.Data.Common;

using System.Globalization;

using System.IO;

using System.Lingq;

using System.Data.SqlClient;
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namespace OneStream.BusinessRule.SmartIntegrationFunction.GetRemoteDataSourceSample

{

public class MainClass

{
public DataTable RunOperation()

{

DataTable dataTableResults = new DataTable();

string connectionString =
OneStreamGatewayService.APILibrary.GetRemoteDataSourceConnection("Sales_Datal");

SqlConnection conn = new SqlConnection(connectionString);

return dataTableResults;

GetRemoteGatewayJobStatus

This BR API returns the status or the results of a previously remotely queued job invoked against
a specified Smart Integration Connector Local Gateway host.

I NOTE: Requires allowRemoteCodeExec = true on Smart Integration Service.

Parameter details:
» si: Sessioninfo object used to create connection objects
« JobID: GUID of remote job ID returned upon successful call to ExecRemoteGatewayJob
« remoteHost: Name of remote host to invoke operation (Smart Integration Connector Name)

The sample below invokes a job as part of a data management job inside a OneStream
extenderrule. The example demonstrates a simple Smart Integration Function that sleeps 2
seconds 1000 times in a loop simulating a long running task. The corresponding extender rule
illustrates how this long running function can be invoked as a job, returning a job ID and
subsequently polled until it's completed.

Here is the 'long running' Smart Integration Function in VB.NET:
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Imports System

Imports System.Collections.Generic
Imports System.Data

Imports System.Data.Common

Imports System.Globalization
Imports System.IO

Imports System.Linqg

Imports System.Threading

Namespace OneStream.BusinessRule.SmartIntegrationFunction.LongRunningTest
Public Class MainClass
Public Shared Function RunOperation() As DataTable
For i As Integer = 1 To 1000
thread.Sleep (2000)
Next

Dim result As String
result = OneStreamGatewayService.APILibrary.GetSmartIntegrationConfigValue("test")

Dim Tablel As DataTable
Tablel = New DataTable("TableName™)

Dim columnl As DataColumn = New DataColumn("SettingName")
columnl.DataType = System.Type.GetType("System.String")

Tablel.Columns.Add(columnl)

Tablel.Rows.Add(result)
Return Tablel

End Function
End Class
End Namespace

It would be typical to invoke long running jobs as part of a Data management/Extender Rule and
the code below is an example on how this could be accomplished inVB.NET:

Public Function Main(ByVal si As SessionInfo, ByVal globals As BRGlobals, ByVal api As Object, ByVal
args As ExtenderArgs) As Object

Try

Dim jobID As Guid

Dim objRemoteRequestResultDto As RemoteRequestResultDto = BRApi.Utilities.ExecRemoteGatewayJob

(si, "LongRunningTest", Nothing, "testConnection",String.Empty)

If (objRemoteRequestResultDto.RemoteResultStatus = RemoteMessageResultType.JobRunning) Then
jobID = objRemoteRequestResultDto.RequestJobID BRApi.ErrorLog.LogMessage
(si, "Remote Job Queued and Running - JobID: " & jobID.ToString())

For loopControl = © To 10
System.Threading.Thread.Sleep(2000)

Dim objJobStatus As RemotelobStatusResultDto = BRApi.Utilities.GetRemoteGatewayJobStatus(si, JobID,
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"testconnection2")

If (objJobStatus.RemoteJobState = RemoteJobState.Running)
BRApi.ErrorLog.LogMessage(si, "Remote Job Still running - JobID: " & jobID.ToString())
Else If (objJobStatus.RemotelobState = RemoteJobState.Completed)

If (Not objJobStatus.RemoteJobResult.ResultSet Is Nothing) Then

Dim xfDT = New XFDataTable(si,objJobStatus.RemoteJobResult.ResultSet,Nothing,1000)
BRApi.ErrorLog.LogMessage(si, "Remote Job Completed - Datatable Returned - JobID: " & jobID.ToString
(O))

Return Nothing

Else If (Not objJlobStatus.RemotelobResult.ResultDataSet Is Nothing)

Then Dim xfDT = New XFDataTable(si,objJobStatus.RemoteJobResult.ResultDataSet.Tables
(0),Nothing,1000)

BRApi.ErrorLog.LogMessage(si, "Remote Job Completed - Dataset Returned - JobID: " & jobID.ToString
()) Return Nothing

Else If (Not objJobStatus.RemoteJobResult.ObjectResultValue Is Nothing) Then
BRApi.ErrorLog.LogMessage

(si, "Remote Job Completed - Object Returned - JobID: " & jobID.ToString())

Return Nothing

End If

Else If (objJobStatus.RemotelobState = RemoteJobState.JobNotFound) BRApi.ErrorLog.LogMessage

(si, "Remote Job Not Found - JobID: " & jobID.ToString()) Return Nothing

Else If (objJobStatus.RemotelobState = RemoteJobState.RequestTimeOut) BRApi.ErrorLog.LogMessage
(si, "Remote Job Timed Out - JobID: " & jobID.ToString()) Return Nothing

Else If (objRemoteRequestResultDto.RemoteResultStatus = RemoteMessageResultType.Exception)

BRApi.ErrorLog.LogMessage(si, "Exception During Exeuction of Job: " &
objRemoteRequestResultDto.RemoteException.ToString())

End If

Next

Else

If (objRemoteRequestResultDto.RemoteResultStatus = RemoteMessageResultType.Exception)
BRApi.ErrorLog.LogMessage(si, "Exception Executing Job: " &
objRemoteRequestResultDto.RemoteException.ToString())

Else

BRApi.ErrorLog.LogMessage(si, "General Job Execution Error - State: " &
objRemoteRequestResultDto.RemoteResultStatus.ToString())

End If

End If

Return Nothing

Catch ex As Exception

Throw ErrorHandler.LogWrite(si, New XFException(si, ex))
End Try

End Function

GetSmartintegrationConfigValue

This BR API allows access to the Local Gateway Local Application Data Settings. Accessing the
remotely stored secret or customer-defined configuration values is done using a new "Remote”
equivalent of the BR APl namespace. This feature can be used to:
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» Reference configuration parameters in a remote business rule running on a Smart
Integration Connector Local Gateway Server

« Store credentials to network resources allowing the developer of remote business rules to
reference values stored in the configuration file instead of having them hard-coded and
viewable by anyone with permission to edit a business rule.

These configuration values are defined and edited using the Smart Integration Connector Local
Gateway Configuration Utility. The API used to obtain these values is demonstrated in the full
business rule example below:

NOTE: Requires allowRemoteCodeExec = True on Smart Integration Local
Gateway.

Here is the rule in C#:

using System;

using System.Collections.Generic;
using System.Data;

using System.Data.Common;

using System.Globalization;

using System.IO;

using System.Ling;

using System.Data.SqlClient;

namespace OneStream.BusinessRule.SmartIntegrationFunction.GetRemoteDataSourceSample

{

public class MainClass

{
public DataTable RunOperation()

{
DataTable dataTableResults = new DataTable();

string connectionString =
OneStreamGatewayService.APILibrary.GetRemoteDataSourceConnection("Sales _Datal");

SqlConnection conn = new SqlConnection(connectionString);

return dataTableResults;

Here is another example in VB.NET:
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Imports System

Imports System.Data

Imports System.Data.Common

Imports System.IO

Imports System.Collections.Generic
Imports System.Globalization
Imports System.Linqg

Imports Microsoft.VisualBasic
Imports OneStream.Shared.Wcf
Imports OneStreamGatewayService

Namespace OneStream.BusinessRule.SmartIntegrationFunction.SecretTester
Public Class MainClass

Public Shared Function RunOperation() as bool
Dim result As String

result = APILibrary.GetSmartIntegrationConfigValue("test")
return true
End Function
End Class
End NameSpace

GetGatewayConnectioninfo

From a OneStream business rule, you can invoke this APl to obtain gateway details such as:
« GatewayName: Name of the remote gateway

+ GatewayVersion: Version of the Smart Integration Connector Gateway Service running on
the remote host

» RemoteGatewayPortNumber: Bound Port at Gateway, the port of the remote service this
direct connection is associated with.

+ RemoteGatewayHost: Name of the remote host associated with the direct connection.

¢ OneStreamPortNumber: Bound Port in OneStream, the port number defined within
OneStream that refers/maps to the specified direct connection.

« SmartintegrationGatewayType: Type of the Smart Integration Connection (0O=Database
Connection, 1=Direct Connection)
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This APl is useful for direct connections where the port number is required before connecting to
remote services such as sFTP or remote Web APIs because each endpoint defined in OneStream
to Smart Integration Connector Local Gateways has a different port number and would need to be
known by the business rule developer at design time. This APl makes it easy to look up the
remote port by knowing the name of the direct connection defined in OneStream. It returns other
useful information outlined below:

Here is the rule in C#:

GatewayDetails gatewayDetailInformation = BRApi.Utilities.GetGatewayConnectionInfo(si,
"democonnection");
int oneStreamPortNumber = gatewayDetailInformation.OneStreamPortNumber;

Dim objGatewayDetails As GatewayDetails = BRApi.Utilities.GetGatewayConnectionInfo(si,
"democonnection")

sessionOpts.PortNumber = objGatewayDetails.OneStreamPortNumber

Imports System

Imports System.Collections.Generic
Imports System.Data

Imports System.Data.Common

Imports System.Globalization
Imports System.IO

Imports System.Linqg

Imports System.Windows.Forms
Imports Microsoft.VisualBasic
Imports OneStream.Finance.Database
Imports OneStream.Finance.Engine
Imports OneStream.Shared.Common
Imports OneStream.Shared.Database
Imports OneStream.Shared.Engine
Imports OneStream.Shared.Wcf
Imports OneStream.Stage.Database
Imports OneStream.Stage.Engine
Imports WinSCP

Namespace OneStream.BusinessRule.Extender.SFTP_Example
Public Class MainClass
Public Function Main(ByVal si As SessionInfo, ByVal globals As BRGlobals, ByVal api
As Object, ByVal args As ExtenderArgs) As Object

Try
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Dim objGatewayDetails As GatewayDetails = BRApi.Utilities.GetGatewayConnectionInfo(si,
"WinSCP_Gateway")
Dim objRemoteRequestResultDto As RemoteRequestResultDto =
BRApi.Utilities.ExecRemoteGatewayBusinessRule
(si, "SFTP_Password", Nothing, "rochester_gateway",String.Empty,"SFTP_Password", False,
600)
' Setup session options
Dim sessionOptions As New SessionOptions
With sessionOptions
.Protocol = Protocol.Sftp
.HostName = "localhost"
'HostName in this instance is in refrence to OneStream and will always be localhost.
.UserName = "onestreamtest”
'SFTP server UserName
' .Passwor‘d = "kkkskskokkkkk!
'sFTP server Password
.Password = CompressionHelper.InflateJsonObject(Of String)
(si,objRemoteRequestResultDto.resultDataCompressed)
'result of remote business rule to provide password from Local Gateway Server
' .PortNumber = 54321 'Bound Port in OneStream
.PortNumber = objGatewayDetails.OneStreamPortNumber 'use BRAPI to populate Port
Number
.SshHostKeyFingerprint = "#fxfskskmisdidmimtikikstrkrtx  'SSH Host Key from sFTP
host
End With

Using session As New Session
Connect
session.Open(sessionOptions)

' Get the filepath

' BatchHarvest in this example is File Share / Applicaitons / GolfStream / Batch /
Harvest

Dim fileUPPath As String = BRAPi.Utilities.GetFileShareFolder(si,
FileShareFolderTypes.BatchHarvest, Nothing)

Dim fileDNPath As String = BRAPi.Utilities.GetFileShareFolder(si,
FileShareFolderTypes.BatchHarvest, Nothing)

' Upload or download files
Dim transferOptions As New TransferOptions
transferOptions.TransferMode = TransferMode.Binary

Dim transferResult As TransferOperationResult

' Upload

fileUPpath = fileUPPath & "\SFTP_TEST_UPLOAD.txt"

transferResult = session.PutFiles(fileUPpath, "/", False, transferOptions)

'Throw on any error
transferResult.Check()

Download
fileDNpath = fileDNPath & "\SFTP_TEST_DOWNLOAD.txt"
transferResult = session.GetFiles("\SFTP_TEST_DOWNLOAD.txt", fileDNpath, False,
transferOptions)

'Throw on any error
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transferResult.Check()
End Using
Return Nothing
Catch ex As Exception
Throw ErrorHandler.LogWrite(si, New XFException(si, ex))
Return Nothing
End Try
End Function

End Class
End Namespace

Incompatible Business Rules

The following business rules are not compatible with Smart Integration Connector:
e CreateSAPConnection
* BRApi.Database.SaveCustomDataTable

If you attempt to use these business rules you will run into an error.

@ OneStream [

1) Unable to execute Business Rule 'SB_SaveCustomDataTable_C'.

2) This BR APl is not compatible with Smart Integration Connector,
Refer to Smart Integration Connector remote BRs.

Obtain Data through a WebAPI

In this scenario, you have a WebAPI (IPaa$S integration or another accessible REST API) to
obtain and pass back data to OneStream. You can use the following remote business rule in
Smart Integration Connector to invoke the API. If you have results that are in JSON format, you
can convert them to a data table and send them back to OneStream. If the data from the WebAPI
is in JSON, you can process the data in Smart Integrator Connector. Additionally, you can send
the raw data back as a string to a data management job for further testing.
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Direct connections are preferred for this method and can be invoked using business rules within

OneStream similar to the sFTP example provided above.

Use the following OneStream business rule to invoke the request.

Dim objRemoteRequestResultDto As RemoteRequestResultDto =
BRApi.Utilities.ExecRemoteGatewayBusinessRule(si, "RemoteWebAPISample", Nothing,
"testconnection"”,String.Empty) If (objRemoteRequestResultDto.RemoteResultStatus =
RemoteMessageResultType.Success) Dim xfDT = New XFDataTable
(si,objRemoteRequestResultDto.resultSet,Nothing,1000) End If

Use the following remote business rule to execute the request in C#

using System;

using System.Collections.Generic;
using System.Data;

using System.Data.Common;
using System.Globalization;
using System.IO;

using System.Ling;

using System.Net;

using System.Net.Http;

using Newtonsoft.Json;

using System.Net.Http.Headers;

namespace OneStream.BusinessRule.SmartIntegrationFunction.RemoteWebAPISample
{

public class MainClass

{
private static readonly HttpClient internalHttpClient = new HttpClient();

static MainClass()
{
internalHttpClient.DefaultRequestHeaders.Accept.Clear();
internalHttpClient.DefaultRequestHeaders.Accept.Add(new MediaTypeWithQualityHeaderValue
("application/json"));
internalHttpClient.DefaultRequestHeaders.Accept.Add(new MediaTypeWithQualityHeaderValue
("application/x-www-form-urlencoded"));
internalHttpClient.DefaultRequestHeaders.Accept.Add(new MediaTypeWithQualityHeaderValue
("application/octet-stream™"));
internalHttpClient.DefaultRequestHeaders.Accept.Add(new MediaTypeWithQualityHeaderValue
("text/plain™));
internalHttpClient.DefaultRequestHeaders.Accept.Add(new MediaTypeWithQualityHeaderValue

(GAVARD DN

}

public DataTable RunOperation()

{

var stringTask = internalHttpClient.GetStringAsync
(https:

var msg = stringTask;

Smart Integration Connector Guide

90



Business Rules

DataTable dt = (DataTable)JsonConvert.DeserializeObject(stringTask.Result,
(typeof(DataTable)));

return dt;
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Troubleshooting

This section provides help on addressing errors in Smart Integration Connector.

Error Log

To view the error log, click System > Logging > Error Log.

Every five minutes, by default, the Smart Integration Connector tries to connect to an established
Smart Integration Connector local gateway from each application server used in a deployment. If
the gateway is unable to connect, it times out and adds an error to the error log. These errors are
recorded in the OneStream error log along with other errors related to the OneStream application.
You can configure the interval at which OneStream application servers monitor this gateway from
1 minute to 1440 minutes (1 day) to reduce the volume of logged failures for infrequently online
test or validation environments.

NOTE: Itis recommended to increase the time intervals for queries that run longer
than five minutes. For example, if you have a query that runs ten minutes long, you
need to set your time interval to above ten minutes (such as fifteen minutes). Time
intervals can be adjusted from System > Smart Integration Connector > Your
connection > Gateway failures reporting interval (min).

= Additional Settings
Bound Port at Gateway
Remote Gateway Host localhost
Bound Port in OneStream

Gateway failures reporting interval {min) 13
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Common Errors

1.

If you receive any of the following errors, increase the memory in your Smart Integration
Connector Local Gateway Server. For queries returning over 1 million records, 32 GB or
more RAM is recommended.

a. "Error while copying content to a stream. Received an unexpected EOF or 0 bytes
from the transport stream."

b. "An error occurred while sending the request. The response ended prematurely."

Gateway Version is empty.

If your gateway is reporting online, is of type "Database Connection" and the Version is
empty, verify with your IT Admin that port 443 is fully open outbound between the SIC Local
Gateway Server and the Azure Relay.

B General (Gatew ay)

: Description + Testing 0L to ArchQA1 DB
Gateway Server Mame JL VM MEW
Web APl Key BETS309
1 K
|
B Additional Sett ngs
Bound Port at Gateway 20433
Gateway failures reparting interval (min) 5

You may not see the Data Source Names populate when setting up the custom connection
with a new gateway. It is recommended to wait for five minutes from creating a new
gateway to when you create the custom connection.

: Data Source Mame
B Timeouts (Select One)
Custom
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4. You receive the error: "Array cannot be null. (Parameter 'bytes')" or
"System.AggregateException - System.NullReferenceException: Object reference not set
to instance of object"

NOTE: CompressionHelper.InflateJsonObject is now automatically executed
as part of remote calls resulting in serialized .NET types returned from the
Smart Integration Connector Gateway. Update any SIC related business rules
accordingly.

Previously, it was required that a OneStream BR developer invoking a remote
Smart Integration Function be aware of the data type returned and convert
accordingly after the result is returned. An example where the returned result
was a byte array involved code that appeared as follows:

@ Example:

bytesFromFile = CompressionHelper.InflateJsonObject(Of System.Byte())
(si,objRemoteRequestResultDto.resultDataCompressed)

bytesFromFile = objRemoteRequestResultDto.ObjectResultValue

5. During compilation of remote business rules using .NET DLLs such as the ERPConnect
Library to interface with SAP, incorrect or missing library references will result in an error
similar (Smart Integration Connector compile error) to the image below.
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ff Extensible Finance

Smart Integration Connector compile error.

1) CAUsers! _ AppData\Local\Ternph2udctens\2udctens.0.vb(9,0) : warning BC40056:
Mamespace or type specified in the Imports [ERPGORNEEt’ doesn't contain any public member
or cannot be found. Make sure the namespace or the type is defined and contains at least
one public member. Make sure the imported element name doesn't use any aliases.

2] ChlUsers! AppData\LocahTemphZudetens\2udctens.0.vb(10,0) @ waming BC40056:
Mamespace or type specified in the Impeorts ‘ERPConnect.Utils' doesn't contain any public
member or cannot be found. Make sure the namespace or the type is defined and contains at
least one public member. Make sure the imported element name doesn't use any aliases.

3) CA\Users AdppDatayLocahTemphZudctens\2udctons.0vb(14,0) : error BC30002: Type
‘R3Connection’ is not defined.

QK

Script Error During Upgrade

During upgrades, you may run into the error "a script required for this install to complete could not
be run." The action to resolve this error is to rerun the Smart Integration Connector installer. If you
continue to see this error during upgrades, contact OneStream support.

ﬁ OneStrearn Smart Integration Connector Gateway Setup X

There is a problem with this Windows Installer package.
I %, Asciptrequired for this install to complete could not be
~  run. Contact your support personnel or package vendaor,

Data Returned as a String

Occasionally, data types can return as a string when you are expecting to see data in the original
source format. Smart Integration Connector transfers data in parquet format from the Local
Gateway Service to OneStream. If you are transferring a data type that is unsupported by parquet,
the data converts and returns as string. You will need to add logic to re-covert the string to the
desired and supported data type if needed.
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Manual Start and Stop

If you run into errors with the service, you may need to manually stop and restart the service. This
can be accomplished in the GUI-based Services control manager as shown below or by using the
command-line/PowerShell. The name of the service when using command line tools is
"OneStreamSmartintegration”

Using the Windows Service Control Manager:

1. Open Services from your Windows start menu.

Help
|HEEl e »®mumn

. Services (Local)

Select an item to view its description.  Name Description  Status  Stertup Type  Log On As
6. OneStream Smart Integration Connector Gateway SmartInteg.. Running  Automatic (..  Local Syste

2. Right-click on OneStream Smart Integration Connector Gateway.

s

Mame

OneStrearmn Smart Integration Connector Gateway

:G} OpenSSH Authentication Agent Start
61 Optimize drives Stop
f,&';F'EﬂGPS Pause
-.E,E!';F'arental Controls Resume
CLP ts and MFC/SE M
A Payments an / anager Restart
{EL Peer Mame Resolution Protocol
-{,E';F'eer Metweorking Grouping All Tasks *
£k Peer Networking Identity Manager
2 Refresh
& Performance Counter DLL Host
Lk Performance Logs & Alerts Properties
&) Phone Service

Help

£} Plug and Play

3. Select Stop.
4. Right-click again and select Start.

Using an elevated command-prompt:
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1. net stop OneStreamSmartintegration
2. net start OneStreamSmartintegration
Using an elevated PowerShell prompt:
1. stop-service -ServiceName OneStreamSmartintegration

2. start-service -ServiceName OneStreamSmartintegration

Communication Error

If you see the following error in the Windows Service Log, it means that you have a mismatched
WebAPIKey. This could occur if the WebAPI key is changed in OneStream and the configuration
for the Smart Integration Local Gateway service is not exported from OneStream and re-imported
into the Local Gateway Server service using the configuration utility.

[14:13:36 INF] HT TP Request with invalid APl key

You can resolve this error by matching the WebAPIKey in the configuration utility.

I NOTE: If the value is changed, you must restart the service.
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